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ABSTRAK 

 

Perkembangan ilmu pengetahuan khususnya mekanika fluida saat ini berkembang sangat pesat, 

terbukti dengan semakin banyak alat-alat yang menggunakan prinsip-prinsip mekanika fluida 

yang beredar dipasaran. Salah satu alat tersebut adalah nosel. Nosel merupakan pipa atau tabung 

yang memiliki luas penampang bervariasi yang digunakan untuk mengontrol laju aliran, 

kecepatan, arah, massa, bentuk, dan tekanan dari aliran fluida. Untuk mendapatkan hasil 

tersebut pada nosel dapat menggunakan beberapa metode, salah satu metode tersebut 

menggunakan metode CFD. 

CFD merupakan metode penghitungan dengan sebuah kontrol dimensi, luas dan volume dengan 

memanfaatkan bantuan komputasi komputer untuk melakukan perhitungan pada tiap-tiap 

elemen pembaginya. Prinsipnya adalah suatu ruang yang berisi fluida yang akan dilakukan 

penghitungan dibagi-bagi menjadi beberapa bagian, bagian-bagian yang terbagi tersebut 

merupakan sebuah kontrol penghitungan yang akan dilakukan oleh aplikasi atau software. 

Pada pernyataan tersebut CFD yang dilakukan menggunakan software Ansys workbrench versi 

16.0 dengan melakukan eksperimen pada nosel 0.3mm. Eksperimen yang dilakukan 

menggunakan nosel spray stasioner untuk menghasilkan kabut dengan mevariasikan tekanan 

60psi, 70psi, 80psi, 90psi, dan 100psi.  

Pada penelitian ini, hasil CFD dibandingkan dengan hasil eksperimen dimana debit air yang di 

dapat pada eksperimen yaitu tekanan 60psi = 3608,773 mL/jam, 70psi = 3949,468 mL/jam, 

80psi = 4169,544 mL/jam, 90psi = 4592,036 mL/jam, 100psi = 4809,380 mL/jam , kemudin 

dari hasil numerik atau CFD didapatkan debit air yaitu tekanan 60psi = 7537,372 mL/jam , 

70psi = 8249,885 mL/jam, 80psi = 8667,214 mL/jam , 90psi = 9071,820 mL/jam , 100psi = 

9654,554 mL/jam.  

 

Kata kunci : CFD ,  tekanan, debit air.
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BAB I 

PENDAHULUAN 

1.1 Latar Belakang 

Perkembangan ilmu pengetahuan khususnya mekanika fluida saat ini berkembang sangat pesat, 

terbukti dengan semakin banyak alat-alat yang menggunakan prinsip-prinsip mekanika fluida 

yang beredar dipasaran. Nosel  merupakan alat yang dirancang untuk mengontrol arah atau 

karakteristik dari aliran fluida, salah satu jenisnya adalah nosel pengabut. Nosel pengabut 

adalah nosel yang dapat menghasilkan butiran fluida yang halus akibat dari penuruanan tekanan 

fluida yang terjadi ketika fluida tersebut bergerak melalui pipa menyempit sehingga tekanan 

menjadi menurun dan kecepatan fluida meningkat. Peningkatan kecepatan dapat dilihat dari 

software yang berbasis Computational Fluid Dynamic (CFD). 

CFD merupakan metode penghitungan dengan sebuah kontrol dimensi, luas dan volume dengan 

memanfaatkan bantuan komputasi komputer untuk melakukan perhitungan pada tiap-tiap 

elemen pembaginya. Prinsipnya adalah suatu ruang yang berisi fluida yang akan dilakukan 

penghitungan dibagi-bagi menjadi beberapa bagian, hal ini sering disebut dengan sel dan 

prosesnya dinamakan meshing. Bagian-bagian yang terbagi tersebut merupakan sebuah kontrol 

penghitungan yang akan dilakukan oleh aplikasi atau software. Kontrol-kontrol penghitungan 

ini beserta kontrol-kontrol penghitungan lainnya merupakan pembagian ruang yang disebutkan 

tadi atau meshing. Nantinya, pada setiap titik kontrol penghitungan akan dilakukan 

penghitungan oleh aplikasi dengan batasan domain dan boundary condition yang telah 

ditentukan. Prinsip inilah yang banyak dipakai pada proses penghitungan dengan menggunakan 

bantuan komputasi komputer. 

Pada penelitian ini, selain ditunjukan untuk mempelajari aliran fluida didalam nosel stationer 

juga ditujukan untuk memperoleh kecepatan pada ujung nosel 0,3 mm. Untuk mendapatkan 

kecepatan dari sebuah model nosel stationer dapat dilakukan dengan mensimulasikan beberapa 

tekanan masuk yang bervariasi. Model nosel stationer dianalisis dengan menggunakan software 

Ansys Workbrench versi 16.0. 

1.2 Perumusan  Masalah  

Rumusan masalah yang ingin penulis ajukan adalah sebagai berikut : 

a. Bagaimana mengukur volume disetiap tekanan ? 
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b. Pengaruh tekanan terhadap volum, bilangan Reynold, dan debit air ? 

c. Hasil perbandingan dari eksperimen dan simulasi numerik ? 

d. Bagaimana memodelkan geometri pada Ansys CFX dan setup boundary condition 

pada software Ansys CFX ? 

1.3 Tujuan Penelitian 

Tujuan yang hendak dicapai dari penelitian ini adalah : 

a. Mengetahui karakteristik aliran fluida pada nosel diameter 0,3 mm. 

b. Membandingkan debit air, bilangan Reynolds, dan discharge coefficient  hasil 

eksperimen dan simulasi numerik. 

1.4 Batasan Masalah 

Dalam Tugas Akhir ini, diharapkan penyelesaian masalah dapat terarah. Sehingga dibuatlah 

batasan masalah pada karya tulis ini, yaitu : 

a. Nosel yang digunakan adalah jenis nosel pengabut. 

b. Diameter outlet nosel sebesar 0,3 mm.  

c. Parameter tekanan yang digunakan 60 psi, 70 psi, 80 psi, 90 psi, dan 100 psi. 

1.5 Metoda Pengumpulan Data  

Hal yang dilakukan dalam melakukan penelitian ini adalah mencakup hal-hal di bawah, yaitu :  

1. Studi Literatur, sebagai dasar dan pendukung penelitian serta pengolahan data, supaya 

dalam pembuatan laporan penelitian tidak menyimpang dari permasaalahan yang 

ditinjau. 

2. Pengambilan data, lalu dilakukan perhitungan untuk mendapatkan perumusan yang 

mengarah pada tujuan peneliti dan kemudian diambil kesimpulan. 

3. Diskusi. 

1.6 Sistematika Penulisan  

Sistematika penulisan laporan ini disusun dengan urutan sebagai berikut : 

BAB I PENDAHULUAN  

 Berisi latar belakang, tujuan penelitian, rumusan maslah, batasan masalah, metoda 

pengumpulan data dan sistematika penulisan. 

 



3 

 

BAB II DASAR TEORI 

 Berisi tentang dasar-dasar teori mengenai laju aliran mekanika fluida pada nosel dan 

pengertian CFD. 

BAB III METODELOGI PENILITIAN 

Membahas tentang metode dan langkah – langkah penelitian yang dilakukan dalam 

eksperimen serta pengujian yang digunakan untuk pengambilan data. 

BAB IV PENGOLAHAN DATA  

Pembahasan tentang perhitungan yang dilakukan pada data pengujian yang 

dibandingkan dengan hasil dari analisis numerik. 

BAB V ANALISA 

Pada bab ini membahas tentang analisa hasil eksperimen dan numerk. 

BAB VI KESIMPULAN DAN SARAN  

Berupa kesimpulan yang diambil dari hasil eksperimen dan numerik serta berisi 

mengenai saran – saran. 
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BAB II 

DASAR TEORI 

2.1 Pengertian Nosel 

Nosel adalah  alat yang dirancang untuk mengontrol arah atau karakteristik dari aliran fluida 

terutama untuk meningkatkan kecepatan saat keluar atau masuk suatu ruangan tertutup atau 

pipa. Nosel memiliki berbagai jenis luas penampang dan dapat digunakan untuk mengarahkan 

atau mengubah aliran fluida (cair atau gas). Nosel sering digunakan untuk mengontrol laju 

aliran, kecepatan, arah, laju aliran massa, bentuk aliran dan tekanan dari aliran fluida tersebut. 

Nosel merupakan pipa atau tabung yang memiliki luas penampang bervariasi. Nosel dapat 

digunakan untuk mengarahkan atau memodifikasi aliran cairan (cairan atau gas). Nosel 

digunakan untuk mengontrol laju aliran, kecepatan, arah, massa, bentuk, dan tekanan dari aliran 

yang muncul dari mereka. Pada sistem spray, nosel berfungsi untuk memecah cairan menjadi 

butiran partikel halus yang menyerupai kabut. Proses pembentukan partikel dengan 

menggunakan tekanan (hydraulic atomization) dilakukan untuk memperoleh butiran halus. 

Hydraulic atomization dilakukan dengan menggunakan air yang dipompa sehingga tekanan air 

meningkat. Air melewati pipa–pipa menuju ke alat pengabut dengan celah yang sempit, 

sehingga cairan akan pecah menjadi partikel-partikel yang sangat halus. Besar butir-butir 

larutan yang terpencarkan dan penyebaran butir-butir tergantung pada gaya tekan udara dan 

lubang nosel. Untuk nosel yang sama, jika semakin tinggi tekanan yang diberikan, maka ukuran 

droplet akan semakin kecil, jika semakin rendah tekanan, maka ukuran droplet akan semakin 

besar. 

Keberhasilan sistem sprayer dalam menghasilkan butiran yang halus dipengaruhi oleh bentuk 

nosel dan kecepatan aliran dari fluida air. Kecepatan gerak suatu fluida memiliki dua efek utama 

tentang bagaimana karakteristik hasil semprotan setelah meninggalkan nosel. Pertama, 

kecepatan perjalanan yang lebih cepat menyebabkan peningkatan udara tegangan geser pada 

lembar semprot yang muncul dari nosel. Hal ini meningkatkan lembar perpisahan dan 

menyebabkan butiran lebih halus, hasil semprot lebih melayang. Kedua, kecepatan lebih cepat 

menyebabkan lebih halus, semprot lebih melayang-layang tetap tinggi, oleh karena itu akan 

menyapu kembali hambatan udara. Hasil akhir sistem sprayer adalah semprotan halus ringan 

sehingga memenuhi ruangan [1]. 
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2.1.1 Jenis – Jenis Nosel 

a. Jets 

Sebuah  jet gas, jet cairan,  atau  jet hydro  adalah nosel dimaksudkan untuk mengeluarkan gas 

atau cairan dalam arus koheren menjadi media sekitarnya. Gas jet biasanya ditemukan di  

kompor gas,  oven, atau  barbecue. Gas jet biasa digunakan untuk cahaya sebelum 

perkembangan lampu listrik . Jenis lain dari fluida jet ditemukan di karburator, dimana halus 

lubang dikalibrasi digunakan untuk mengatur aliran bahan bakar ke mesin, dan di Jacuzzi atau 

spa. 

Sebuah nosel jet akan memiliki daerah tenggorokan yang lebih besar dan jumlah ruang tekanan 

yang lebih rendah daripada roket dan nosel. Input output dapat dilakukan baik menggunakan 

unit bahasa Inggris atau Satuan metrik yang dipilih dengan menggunakan tombol pilihan. Lain 

jet khusus adalah laminar jet. Ini adalah jet air yang berisi perangkat untuk kelancaran keluar 

dari tekanan dan aliran, dan memberikan  aliran laminar, seperti namanya. Ini memberikan hasil 

yang lebih baik untuk  air mancur. Nosel digunakan untuk pakan ledakan panas ke dalam tungku 

blast atau memalsukan disebut tuyeres . Ada beberapa yang berbeda jenis mesin jet, tapi semua 

mesin jet memiliki beberapa bagian yang sama dengan jet Semua mesin   memiliki   nosel   yang 

menghasilkan dorong. Juga menetapkan total laju aliran massa melalui mesin seperti yang 

dijelaskan pada slide terpisah. nosel duduk  hilir dari turbin kekuasaan dan, sementara nosel 

tidak melakukan kerja pada aliran, ada beberapa fitur desain penting dari nosel. 

b. Nosel Magnetic 

Magnetic nosel juga telah diusulkan untuk beberapa jenis penggerak, seperti Vasimr, di mana 

aliran plasma diarahkan oleh medan magnet , bukan dinding yang terbuat dari materi padat. 

c. Nosel Spray 

Banyak nosel menghasilkan semprot yang sangat halus cairan. Nosel Pengabut digunakan 

untuk lukisan semprot, parfum, alat untuk cuci motor dan mobil, Karburator untuk mesin 

pembakaran internal, semprot pada deodoran, antiperspirant dan banyak kegunaan lain. Air-

Aspirating Nosel menggunakan pembukaan di nosel berbentuk kerucut untuk menyuntikkan 

udara ke aliran berdasarkan busa air untuk membuat berkonsentrasi pada busa up. Paling sering 

ditemukan pada alat pemadam busa dan handlines busa. 
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d. Nosel Swirl 

Menyuntikkan cairan di tangensial, dan spiral ke pusat dan kemudian keluar melalui lubang 

pusat. Karena vortexing ini menyebabkan semprot untuk keluar dalam bentuk kerucut [1]. 

2.1.2 Karakteristik Semprotan 

a. Hollow Cone Nozzel  

Solid cone nozzle menghasilkan semprotan halus. Pola semprotan berbentuk bulat (kerucut). 

Terdiri dari 2 tipe, yaitu zolid/full cone nozzle dan hollow cone nozzle. Solid cone nozze pola 

semprotan bulat penuh berisi, sedangkan hollow cone nozzle pada Gambar 2.1 menghasilkan 

semprotan berbentuk kerucut bulat kosong. Digunakan terutama untuk aplikasi insektisida dan 

fungisida. 

 

Gambar 2. 1 Hollow cone nozzle [2] 

 

b. Flat Fan Nozzle 

Flat fan nozzle pada Gambar 2.2 adalah jenis nosel yang paling umum digunakan dari nosel 

yang diguakan dalam  pertanian.  Nosel yang dapat menghasilkan pola semprotan berbentuk 

oval (V). Untuk mendapatkan sebaran droplet yang merata diusahakan melakukan 

penyemprotan dengan saling tumpang tindih (overlapping). Digunakan terutama untuk aplikasi 
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herbisida, tetapi bisa juga digunakan untuk fungisida dan insektisida [2]. Nosel ini mempunyai 

beberapa jenis lainnya, yaitu : 

 Standard flat-fan; 

 Even (E) flat-fan; 

 Low pressure flat-fan; 

 Off center (OC) flat-fan; and 

 Twin orifice (TJ) flat-fan [3]. 

 

 

Gambar 2. 2 Flat fan nozzle [3] 

c. Flood Nosel  

Flood nozzle pada Gambar 2.3 adalah nosel yang mempunyai pola semprotan yang berbentuk 

garis atau cerutu. Butiran semprot agak kasar hingga kasar. Tidak atau sangat sedikit 

menimbulkan drift dan hanya digunakan untuk aplikasi herrbisida [4]. 

 

Gambar 2. 3 Flood nozzle [4] 



8 

 

2.1.3 Konvergen dan Divergen 

1. Nosel Konvergen 

Yaitu nosel dengan penampang mula-mula yang besar yang kemudian mengecil pada bagian 

keluarnya sehingga kecepatan aliran menjadi tinggi dan tekanannya turun. Salah satu contoh 

penerapan nossel konvergen yaitu pada engine turboprop yang digunakan pada pesawat 

kargo.Jenis turbo prop memiliki system tidak jauh berbeda dengan turbo jet, akan tetapi energi 

( thrust ) dihasilkan oleh putaran propeller sebesar 85 %, dimana putaran propeller ini 

digerakkan oleh turbin yang menerima expansi energy dari hasil pembakaran, sisanya 15 % 

menjadi exhaust jet thrust (hot gas), Turboprop engine lebih efisien dari pada turbojet, 

dirancang untuk terbang dengan kecepatan di bawah sekitar 800 km / h (500 mph) [5]. 

2. Nosel Divergen 

Nosel divergen adalah nosel dengan penampang mula-mula yang kecil kemudian membesar 

pada bagian keluarnya sehingga kecepatannya turun dan tekanannya naik. Contoh penerapan 

nosel divergen adalah pada bagian belakang roket menuju angkasa luar. Pada moon rocket 

dibutuhkan tekanan yang besar untuk mengangkat rocket sehingga digunakan nosel divergen 

[5]. 

3. Nosel Konvergen-Divergen 

Nosel konvergen-divergen  yaitu merupakan gabungan dari nossel konvergen dan nosel 

divergen. Contoh Penerapan Nossel Konvergen-Divergen adalah pada Turbo Fan adalah jenis 

engine yang termodern saat ini yang menggabungkan teknologi Turbo Prop dan Turbo Jet. 

Mesin ini sebenarnya adalah sebuah mesin by-pass dimana sebagian dari udara dipadatkan dan 

disalurkan ke ruang pembakaran, sementara sisanya dengan kepadatan rendah disalurkan 

sekeliling bagian luar ruang pembakaran (by-pass). Sekaligus udara tersebut berfungsi untuk 

mendinginkan engine. Tenaga gaya dorong (Thrust) terbesar dihasilkan oleh FAN (baling-

baling paling depan yang berukuran panjang), menghasilkan thrust sebesar 80 % (secondary 

airflow), dan sisanya 20 % menjadi exhaust jet thrust (hot gas). Sepintas mesin turbo fan ini 

mirip turbo prop, namun baling-baling depan dari turbo fan memiliki ruang penutup (Casing / 

Fan case) [5]. 
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2.2 Pengertian Fluida 

Fluida adalah zat yang dapat mengalir. Kata Fluida mencakup zat car, air dan gas karena kedua 

zat ini dapat mengalir, sebaliknya batu dan benda-benda keras atau seluruh zat padat tidak 

digolongkan kedalam fluida karena tidak bisa mengalir. Susu, minyak pelumas, dan air 

merupakan contoh zat cair. dan Semua zat cair itu dapat dikelompokan ke dalam fluida karena 

sifatnya yang dapat mengalir dari satu tempat ke tempat yang lain. Selain zat cair, zat gas juga 

termasuk fluida. Zat gas juga dapat mengalir dari satu satu tempat ke tempat lain. Hembusan 

angin merupakan contoh udara yang berpindah dari satu tempat ke tempat lain. Fluida 

merupakan salah satu aspek yang penting dalam kehidupan sehari- hari. Setiap hari manusia 

menghirup udara, meminum, terapungatau tenggelam didalamnya.  Setiap hari pesawat udara 

terbang melaluinya dan kapal laut mengapung di atasnya. Demikian juga kapal selam dapat 

mengapung atau melayang di dalamnya. Air yang diminum dan udara yang dihirup juga 

bersirkulasi di dalam tubuh manusia setiap saat meskipun sering tidak disadari.  

1.     Sifat – sifat fluida dibagi menjadi tiga adalah  

a. Tidak dapat melawan secara tetap stress geser. 

b. Mempunyai komprebilitas. 

c. Mempunyai kekentalan atau viskositas. 

2.      Fluida ini dapat kita bagi menjadi dua bagian yakni: 

 Materi fluida statis terdiri dari : 

a. Tekanan  

b. Tegangan permukaan  

c. Kapilaritas 

 Materi fluida dinamis terdiri dari : 

a. Persamaan Kontinuitas 

b. Persamaan Bernaoulli 

c. Viskositas 

2.2.1 Pengertian  Fluida  statis 

Fluida Statis adalah fluida yang berada dalam fase tidak bergerak (diam) atau fluida dalam 

keadaan bergerak tetapi tak ada perbedaan kecepatan antar partikel fluida tersebut atau bisa 

dikatakan bahwa partikel-partikel fluida tersebut bergerak dengan kecepatan seragam sehingga 

tidak memiliki gaya geser. Contoh fenomena fluida statis dapat dibagi menjadi statis sederhana 

dan tidak sederhana. Contoh fluida yang diam secara sederhana adalah air di bak yang tidak 
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dikenai gaya oleh gaya apapun, seperti gaya angin, panas, dan lain-lain yang mengakibatkan 

air tersebut bergerak. Contoh fluida statis yang tidak sederhana adalah air sungai yang memiliki 

kecepatan seragam pada tiap partikel di berbagai lapisan dari permukaan sampai dasar 

sungai.Cairan yang berada dalam bejana mengalami gaya-gaya yang seimbang sehingga cairan 

itu tidak mengalir. Gaya dari sebelah kiri diimbangi dengan gaya dari sebelah kanan, gaya dari 

atas ditahan dari bawah. Cairan yang massanya menekan dasar bejana dengan gaya sebesar Mg. 

Gaya ini tersebar merata pada seluruh permukaan dasar bejana. Selama cairan itu tidak mengalir 

(dalam keadaan statis), pada cairan tidak ada gaya geseran sehingga hanya melakukan gaya ke 

bawah oleh akibat berat cairan dalam kolom tersebut [6]. 

1. Tekanan 

Besar tekanan di definisikan sebagai gaya tiap satuan luas. Apabila gaya sebesar F   bekerja 

secara tegak lurus dan merata pada permukaan bidang seluas A, tekanan pada permukaan itu 

dapat di rumuskan tekanan  sebagai berikut: 

 

𝑃 = 𝐹/𝐴  (2.1) 

 

Keterangan :  

P = tekanan (N/m2) 

F = gaya (N) 

A = luas (m2) 

Satuan tekanan dalam SI adalah N/m2  atau disebut juga Pascal (Pa). untuk tekanan udara 

kadang-kadang digunakan satuan atmosfer (atm), cm raksa (cmHg), mmHg (atau torr dari 

Torricelli) atau milibar (mb) [6]. 

Aturan konversinya adalah sebagai berikut : 

1 mb = 10-3 bar 

1 bar = 105 Pa 

1 atm = 76 cmHg = 1,01 x 105 Pa 

1 mmHg = 1 torr = 1,316 x 10-3 atm = 133,3 Pa 

 Tekanan Hidrostatik 

Tekanan hidrostatis adalah tekanan pada zat cair yang diam. Besarnya tekanan hidrostatis 

tergantung pada jenis dan kedalaman zat cair, tidak tergantung pada bentuk wadahnya. 
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Besarnya tekanan hidrostatis dirumuskan dengan : 

𝑃 =  𝜌 𝑔 ℎ (2.2) 

 Keterangan: 

P = tekanan (Pa) 

ρ = massa jenis zat cair (kg/m3) 

g = perepatan gravitasi bumi (m/s2) 

h = kedalaman (m)                                                       

Pernyataan di atas dikenal sebagai hukum utama hidrostatika. Perhatikan gambar berikut: 

"Tekanan hidrostatik pada sembarang titik yang jenis zat cair yang diam, besarnya 

sama."terletak pada satu bidang datar di dalam satu  

Hukum utama hidrostatika dapat diterapkan untuk menentukan masa jenis zat cair dengan 

menggunakan pipa U. Dalam hal ini, dua cairan yang digunakan tidak akan tercampur [6].  

 Tekanan Gauge 

Tekanan Gauge adalah selisih antara tekanan yang tidak diketahui dengan tekanan atmosfer 

(tekanan udara luar).Nilai tekanan yang diukur oleh alat pengukur tekanan adalah tekanan 

gauge.Adapun tekanan sesungguhnya disebut dengan tekanan mutlak. 

Tekanan mutlak = tekanan gauge + tekanan atmosfer 

          P = Pgauge + Patm   (2.3) 

 Tekanan Mutlak Pada Suatu Kedalaman Zat Cair 

Tekanan hidrostatis zat cair dapat kita miripkan dengan tekanan gauge.Dengan 

demikian,tekanan mutlak pada kedalam h dirumuskan sebagai berikut. 

 

𝑃 = 𝑃0 + 𝜌𝑔ℎ  (2.4) 

Keterangan: 

P = tekanan hidrostatika (Pa) 

P0 = tekanan atmosfer (Pa) 

Ρ = massa jenis (kg/m3) 

g = percepatan gravitasi (m/s2) 

h = kedalaman (m) 

Pemahaman tekanan gauge dengan melakukan percobaan yang menggunakan sebuah 

kaleng/wadah yang diberikan dua lubang pada sisinya kemudian diisi dengan air hingga penuh.  
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Pabsolut = Patmosfer + Phidrostatis 

   Pabs = Patm + ρgh  (2.5) 

 

Air terpancar dari lubang-lubang kedua sisi kaleng.Ketika kaleng diangkat dan dipercepat 

keatas maka jarak pancaran air dari kedua lubang semakin jauh dengan lubang.Tapi, ketika 

kaleng dijatuhkan dari suatu ketinggian, jarak pancaran air dari kedua lubang menjadi dekat 

dengan lubang [6]. 

2.2.2 Fluida Dinamis 

Macam – macam fluida dinamis : 

a. Aliran steady (stasioner) 

b. Aliran viscous 

c. Aliran turbulen 

 Persamaan Kontinitas dan Benoulli 

Persamaan Kontinuitas menyatakan hubungan anatar kecepatan fluida yang masuk pada suatu 

pipa terhadap kecepatan fluida yang keluar. Hubungan tersebut dinyatakan sebagai berikut : 

𝑣1𝐴1  =  𝑣2𝐴2  =  𝑄   (2.6) 

  Keterangan : 

Q = debit aliran (m3/s) 

A = luas penampang (m2) 

V = laju aliran fluida (m/s) 

Debit aliran (Q) Aliran fluida sering dinyatakan dalam debit aliran : 

 

𝑄 = 𝑉/𝑡   (2.7) 

 

Keterangan : 

Q = debit aliran (m3/s) 

V = volume (m3) 

 t = selang waktu (s) 

 Persamaan bernoulli 

Hukum Bernoulli adalah hukum yang berlandaskan pada hukum kekekalan energi yang dialami 

oleh aliran fluida. Hukum ini menyatakan bahwa jumlah tekanan (p), energi kinetik per satuan 
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volume, dan energi potensial per satuan volume memiliki nilai yang sama pada setiap titik 

sepanjang suatu garis arus. Jika dinyatakan dalam persamaan menjadi [6] : 

𝑃1 +
1

2
𝜌𝑣1

 2 +  𝜌𝑔ℎ1 =  𝑃2 +
1

2
𝜌𝑣2

 2 +  𝜌𝑔ℎ2       (2.8) 

Keterangan : 

P = tekanan air (Pa) 

ρ = massa jenis (kg/m3) 

v = kecepatan air (m/s) 

g = percepatan gravitasi (m/s2) 

h = ketinggian air (m) 

2.3 Pengertian Bilangan Reynold 

Dalam mekanika fluida, bilangan Reynolds adalah rasio antara gaya inersia (vsρ) terhadap gaya 

viskos (μ/L) yang mengkuantifikasikan hubungan kedua gaya tersebut dengan suatu kondisi 

aliran tertentu. Bilangan ini digunakan untuk mengidentikasikan jenis aliran yang berbeda, 

misalnya laminar dan turbulen. 

Namanya diambil dari Osborne Reynolds (1842–1912) yang mengusulkannya pada 

tahun 1883. Bilangan Reynold merupakan salah satu bilangan tak berdimensi yang paling 

penting dalam mekanika fluida dan digunakan, seperti halnya dengan bilangan tak berdimensi 

lain, untuk memberikan kriteria untuk menentukan dynamic similitude. Jika dua pola aliran 

yang mirip secara geometris, mungkin pada fluida yang berbeda dan laju alir yang berbeda pula, 

memiliki nilai bilangan tak berdimensi yang relevan. 

Rumus bilangan Reynolds umumnya diberikan sebagai berikut [7]: 

𝑅𝑒 =  𝜌𝑣𝑠𝐿/𝜇 =  𝜈𝑠 𝐿/𝑣 =  𝐺𝑎𝑦𝑎 𝐼𝑛𝑒𝑟𝑠𝑖𝑎 / 𝐺𝑎𝑦𝑎 𝑉𝑖𝑠𝑘𝑜𝑠          (2.9) 

Keterangan : 

vs = kecepatan fluida (m/s) 

L  = panjang karakteristik (m) 

μ  = viskositas absolut fluida dinamis 

ρ  = kerapatan fluida (kg/m3) 

 

http://id.wikipedia.org/w/index.php?title=Laminar&action=edit&redlink=1
http://id.wikipedia.org/w/index.php?title=Turbulen&action=edit&redlink=1
http://id.wikipedia.org/w/index.php?title=Osborne_Reynolds&action=edit&redlink=1
http://id.wikipedia.org/wiki/1842
http://id.wikipedia.org/wiki/1912
http://id.wikipedia.org/wiki/1883
http://id.wikipedia.org/wiki/Bilangan_tak_berdimensi
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2.3.1 Jenis Jenis Bilangan Reynold 

1. Laminer 
 

Laminer pada Gambar 2.4 adalah aliran partikel-partikel fluida yang bergerak secara paralel 

(tidak saling memotong). Contohnya: aliran lambat dari cairan kental. Perlu diingat: suatu aliran 

fluida (gas / cair) dapat berupa aliran laminer atau turbulen ditentukan (dihitung) berdasarkan 

angka Reynold (Reynold number). 

 

Gambar 2. 4 Laju aliran laminer [10] 

2. Turbulen 
 

Gambar 2.5 merupakan kecepatan aliran yang relatif besar akan menghasilakan aliran yang 

tidak laminar melainkan komplek, lintasan gerak partikel saling tidak teratur antara satu dengan 

yang lain. Sehingga didapatkan Ciri dari lairan turbulen adalah tidak adanya keteraturan dalam 

lintasan fluidanya, aliran banyak bercampur, kecepatan fluida tinggi, panjang skala aliran besar 

dan viskositasnya rendah. Karakteristik aliran turbulen ditunjukkan oleh terbentuknya pusaran-

pusaran dalam aliran, yang menghasilkan percampuran terus menerus antara partikel partikel 

cairan di seluruh penampang aliran. 

 

Gambar 2. 5 Laju aliran turbulent [10] 

Angka ini dihitung dengan persamaan sebagai berikut: 

𝑅𝑒 =  (4 𝑣 𝑅)/𝜗     (3.0) 

Keterangan: 

Re  = angka Reynold  



15 

 

v  = kecepatan rata-rata (m/s) 

R = jari-jari hydraulik (m) 

ϑ  = viskositas kinematis, tersedia dalam tabel sifat-sifat cairan (m2/s) 

Menurut hasil percobaan oleh Reynold, apabila angka Reynold <2000, aliran biasanya 

merupakan aliran laminer. Apabila angka Reynold >4000, aliran biasanya adalah turbulen. 

Sedang antara 2000 dan 4000 aliran dapat laminer atau turbulen tergantung pada faktor-faktor 

lain yang mempengaruhi [7]. 

2.4 Pengertian Computational Fluid Dynamics (CFD) 

CFD merupakan metode penghitungan dengan sebuah kontrol dimensi, luas dan volume dengan 

memanfaatkan bantuan komputasi komputer untuk melakukan perhitungan pada tiap-tiap 

elemen pembaginya. Prinsipnya adalah suatu ruang yang berisi fluida yang akan dilakukan 

penghitungan dibagi-bagi menjadi beberapa bagian, hal ini sering disebut dengan sel dan 

prosesnya dinamakan meshing. Bagian-bagian yang terbagi tersebut merupakan sebuah kontrol 

penghitungan yang akan dilakukan oleh aplikasi atau software. Kontrol-kontrol penghitungan 

ini beserta kontrol-kontrol penghitungan lainnya merupakan pembagian ruang yang disebutkan 

tadi atau meshing. Nantinya, pada setiap titik kontrol penghitungan akan dilakukan 

penghitungan oleh aplikasi dengan batasan domain dan boundary condition yang telah 

ditentukan. Prinsip inilah yang banyak dipakai pada proses penghitungan dengan menggunakan 

bantuan komputasi komputer. Contoh lain penerapan prinsip ini adalah Finite Element Analysis 

(FEA) yang digunakan untuk menghitung tegangan yang terjadi pada benda solid. 

Sejarah CFD berawal pada tahun 60-an dan mulai terkenal pada tahun 70-an, awalnya 

pemakaian konsep CFD hanya digunakan untuk aliran fluida dan reaksi kimia, namun seiring 

dengan berkembangnya industri di tahun 90-an membuat CFD makin dibutuhkan pada berbagai 

aplikasi lain. Contohnya sekarang ini banyak sekali paket-paket software CAD menyertakan 

konsep CFD yang dipakai untuk menganalisa stress yang terjadi pada design yang dibuat. 

Pemakain CFD secara umum dipakai untuk memprediksi [8]: 

 Aliran dan panas. 

 Transfer massa. 

 Perubahan fasa  seperti pada proses melting, pengembunan dan pendidihan. 

 Reaksi kimia seperti pembakaran. 

 Gerakan mekanis seperti piston dan fan. 

 Tegangan dan tumpuan pada benda solid. 
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 Gelombang elektromagnet. 

CFD adalah penghitungan yang mengkhususkan pada fluida, mulai dari aliran fluida, heat 

transfer dan reaksi kimia yang terjadi pada fluida. Atas prinsip-prinsip dasar mekanika fluida, 

konservasi energi, momentum, massa, serta species, penghitungan dengan CFD dapat 

dilakukan. Gambar 2.6 merupakan proses sederhana penghitungan yang dilakukan oleh aplikasi 

CFD adalah dengan kontrol-kontrol penghitungan yang telah dilakukan maka kontrol 

penghitungan tersebut akan dilibatkan dengan memanfaatkan persamaan-persamaan yang 

terlibat. Persamaan-persamaan ini adalah persamaan yang dibangkitkan dengan memasukkan 

parameter apa saja yang terlibat dalam domain. Misalnya ketika suatu model yang akan 

dianalisa melibatkan temperatur berarti model tersebut melibatkan persamaan energi atau 

konservasi dari energi tersebut. Inisialisasi awal dari persamaan adalah boundary condition. 

Boundary condition adalah kondisi dimana kontrol-kontrol perhitungan didefinisikan sebagi 

definisi awal yang akan dilibatkan ke kontrol-kontrol penghitungan yang berdekatan dengannya 

melalui persamaan-persamaan yang terlibat. 

 

 

Gambar 2. 6 Gambaran umum proses CFD [8] 

Hasil yang didapat pada kontrol point terdekat dari penghitungan persamaan yang terlibat akan 

diteruskan ke kontrol point terdekat lainnya secara terus menerus hingga seluruh domain 

terpenuhi. Akhirnya, hasil yang didapat akan disajikan dalam bentuk warna, vektor dan nilai 

yang mudah untuk dilihat dengan konfigurasi jangkauan diambil dari nilai terbesar dan terkecil. 

Secara umum proses penghitungan CFD terdiri atas 3 bagian utama: 

1. Pre processor (Input) 

2. Processor 

3. Post processor (Output) 
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Prepocessor adalah tahap dimana data diinput mulai dari pendefinisian domain serta 

pendefinisan kondisi batas atau boundary condition. Ditahap itu juga sebuah benda atau 

ruangan yang akan analisa dibagi-bagi dengan jumlah grid tertentu atau sering disebut juga 

dengan meshing. Tahap selanjutnya adalah processor, pada tahap ini dilakukan proses 

penghitungan data-data input dengan persamaan yang terlibat secara iteratif. Artinya 

penghitungan dilakukan hingga hasil menuju error terkecil atau hingga mencapai nilai yang 

konvergen. Penghitungan dilakukan secara menyeluruh terhadap volume kontrol dengan proses 

integrasi persamaan diskrit. Tahap akhir merupakan tahap post processor dimana hasil 

perhitungan diinterpretasikan ke dalam gambar, grafik bahkan animasi dengan pola-pola warna 

tertentu. 

Hal yang paling mendasar mengapa konsep CFD (software CFD) banyak sekali digunakan 

dalam dunia industri adalah dengan CFD dapat dilakukan analisa terhadap suatu sistem dengan 

mengurangi biaya eksperimen dan tentunya waktu yang panjang dalam melakukan eksperimen 

tersebut. Atau dalam proses design engineering tahap yang harus dilakukan menjadi lebih 

pendek. Hal lain yang mendasari pemakaian konsep CFD adalah pemahaman lebih dalam akan 

suatu masalah yang akan diselesaikan atau dalam hal ini pemahaman lebih dalam mengenai 

karakteristik aliran fluida dengan melihat hasil berupa grafik, vektor, kontur dan bahkan 

animasi [8]. 

2.4.1 Pengertian Ansys  

Ansys adalah sebuah software analisis elemen hingga dengan kemampuan menganalisa dengan 

cakupan yang luas untuk berbagai jenis masalah ( Tim Langlais, 1999). Ansys mampu 

memecahkan persamaan differensial dengan cara memecahnya menjadi elemen-elemen yang 

lebih kecil. Pada awalnya program ini bernama Stasys (Structural Analysis System), kemudian 

berganti nama menjadi Ansys yang ditemukan pertama kali oleh Dr. John Swanson pada tahun 

1970. Ansys merupakan tujuan utama dari paket permodelan elemen hingga untuk secara 

numerik memecahkan masalah mekanis yang berbagai macam. Masalah yang ada termasuk 

analisa struktur statis dan dinamis (baik linear dan non-linear), distribusi panas dan masalah 

cairan, begitu juga dengan ilmu bunyi dan masalah elektromagnetik.  

Teknologi Ansys mekanis mempersatukan struktur dan material yang bersifat non-linear. Ansys 

multiphysic juga mengatasi masalah panas, struktur, elektromagnetik, dan ilmu bunyi. Program 

Ansys dapat digunakan dalam teknik sipil, teknik listrik, fisika dan kimia [9].  
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2.4.2 Cara Kerja Ansys 

Ansys bekerja dengan sistem metode elemen hingga, Gambar 2.7 merupakan  penyelesaiannya 

pada suatu objek dilakukan dengan memecah satu rangkaian kesatuan menjadi bagian-bagian 

yang lebih kecil dan dihubungkan dengan node.  

 

Gambar 2. 7 Material yang disusun dengan node [9] 

Hasil yang diperoleh dari ANSYS ini berupa pendekatan dengan  menggunakan analisa 

numerik. Ketelitiannya sangat bergantung pada cara kita memecah model tersebut dan 

menggabungkannya. Secara umum, suatu solusi elemen hingga dapat dipecahkan dengan 

mengikuti 3 tahap ini. Ini merupakan panduan umum yang dapat digunakan untuk menghitung 

analisis elemen hingga.  

1. Preprocessing  

Langkah-langkah dalam preprocessing yaitu:  

• Mendefinisikan titik point, garis, luas, volume  

• Mendefinisikan jenis elemen dan bentuk material/geometri  

• Menghubungkan garis, luas, volume sesuai kebutuhan.  

 

2. Solusi 

Menetapkan beban, perletakan dan menjalankan analisis beban yang ada berupa beban terpusat 

dan terbagi rata, perletakan ( translasi dan rotasi) dan terakhir menjalankan analisisnya.  

3. Postprocessing 

Postprocessing proses lebih lanjut dan menampilkan hasil analisisnya, dalam hal ini dapat 

ditampilkan :  

• Tabel perpindahan nodal  

• Tabel gaya dan momen  

• Defleksi (penurunan)  

• Diagram kontur tegangan dan regangan [9]. 
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BAB III 

DIAGRAM ALIR 

3.1 Diagram Alir  

Diagram alir adalah proses serta langkah-langkah yang akan diambil dalam penyelesaian tugas 

akhir. Gambar 3.1 merupakan diagram alir pada tugas akhir ini agar mempermudah dan 

memahami dalam pengerjaan. 

 

 

Gambar 3. 1 Diagram alir pengerjaan 
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3.2 Set Up Pengujian 

Set up pengujian pada Gambar 3.2 merupakan rencana pengujian yang dilakukan untuk mencari 

data numerik pada pengerjaan tugas akhir. 

 

Gambar 3. 2 Skematis eksperimen  

 

Keterangan : 

1. Tanki air / ember 

2. Selang 

3. Pompa diafragma  

4. Fitting 

5. Valve 

6. Pressure gauge 

7. Nosel 

8. Dudukan Nosel 

9. Kamera dan tripod 
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3.3 Proses Eksperimen 

Pada eksperimen ini menggunakan nosel berdiameter 0,3 mm dengan jumlah nosel 1 (satu) 

buah yang dilakukan sekitar pukul 08.30 – 10.00 WIB, karena untuk pengambilan photo 

eksperimen ini membutuhkan cahaya sinar matahari yang langsung menyinari kabut dari nosel. 

Berikut ini prosedur eksperimen yang dilakukan: 

a. Pasang selang pada pompa diafragma in (air masuk) dan out (air keluar). 

b. Rangkai alat-alat seperti pada gambar. Pasang alat-alat dengan benar agar tidak terjadi 

kebocoran pada sambungan selang, karena kebocoran pada sambungan dapat 

mengurangi tekanan air. 

c. Isi tanki air sampai penuh. 

d. Pasang background pada dinding yang menghadap nosel dan kamera. Background harus 

bewarna hitam, karena untuk memperjelas hasil kabut dan mengurangi pantulan cahaya 

matahari pada hasil foto dengan ukuran sebesar 1,5 x 1 m. 

e. Air dialirkan oleh pompa diafragma dari tanki sampai ke nosel melalui selang. 

f. Nyalakan pompa diafragma tunggu sampai nosel mengeluarkan kabut, kemudian atur 

tekanan air pada katup 1 dan katup 2 (karena jika hanya menggunakan 1 katup tekanan 

air tidak stabil) sampai tekanan di pressure gauge  stabil. 

g. Setelah tekanan air diatur pada tekanan 60psi, 70psi, 80psi, 90psi, dan 100psi tunggu 

beberapa detik  sampai keadaan steady. 

h. Pengujian yang dilakukan seperti Gambar 3.3 dimana hasil kabut yang keluar dari nosel 

difoto dengan menggunakan kamera Canon 600D. Agar kabut tersebut tampak jelas 

ketika di foto maka diperlukan posisi kamera dan pencahayaan yang cukup, yaitu 

dengan bantuan sinar matahari. 

 

Gambar 3. 3 Skematis studio eksperimen 

i. Studio harus tertutup agar kabut tidak terpengaruhi oleh angin. 
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3.4 Peralatan yang Digunakan  

Peralatan yang digunakan pada studi eksperimen dan kajian numerik pada nosel stationer adalah 

sebagai berikut : 

a. Pompa Diafragma  

Pompa diafragma pada Gambar 3.4 berfungsi untuk mengalirkan dan menaikan tekanan 

air dengan spesifikasi pompa sebagai berikut : 

 Tegangan input  : 24 volt DC 

 Kuat arus    : 0,65 A 

 Tekanan kerja   : 80 psi = 5,51 bar 

 Tekanan bypass  : 125 psi = 8,61 bar 

 Daya listrik   : 15,6 watt 

 

Gambar 3. 4 Pompa diafragma C.C.K 

b. Pressure Gauge 

Preassure gauge pada Gambar 3.5 merpukan alat yang digunakan untuk mengukur 

tekanan air sebelum keluar nosel adalah preassure. 

 

Gambar 3. 5 Pressure gauge 
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c. Nosel 

Nosel pengabut pada Gambar 3.6 berfungsi sebagai alat untuk menurunkan tekanan 

pada air. 

 

Gambar 3. 6 Nosel pengabut  

d. Katup  

Katub pada Gambar 3.7 digunakan untuk mengatur tekanan air sebelum keluar dari 

nosel. 

 

Gambar 3. 7 Katup pengatur tekanan 

e. Selang High Pressure 

Pada Gambar 3.8 merupakan selang high preassure yang digunakan untuk mengalirkan 

air dari tanki air ke nosel dengan ukuran selang sebesar 1/4 inch dan 1/8 inch. 

 

Gambar 3. 8 Selang high pressure 
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f. Fitting  

Fitting pada Gambar 3.9 digunakan untuk menyambungkan antar selang ke rangakaian 

lainnya. 

 

Gambar 3. 9 Fitting 

g. Gelas Ukur  

Gelas ukur pada Gambar 3.10 digunakan untuk mengukur volume air yang keluar dari 

nosel. 

 

Gambar 3. 10 Gelas ukur 

h. Kamera 

Kamera yang digunakan untuk mengambil gambar kabut yang dihasilkan oleh nosel 

yang nantinya akan di analisis seperti Gambar 3.11. Berikut adalah spesifikasi kamera: 

 Merk    : Canon EOS 600D 

 F-stop   : f/4 

 Exposure Time  : 1/300 sec 

 ISO Speed   : ISO - 200 
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 Exposure Bias  : 0 step 

 Focal Length  : 70 mm 

 Matering Mode   : pattern 

 Flash Mode  : no flash, compulsory 

 Dimension   : 2592 x 1728 

 Width   : 2592 pixels 

 Height   : 1728 pixels 

 Horizontal Resolutions : 72 dpi 

 Vertical Resolutions : 72 dpi 

 Bit Depth   : 24 

 Resolution Unit   : 2 

 Color Representation  : sRGB 

 

Gambar 3. 11 Kamera  

i. Dudukan Nosel  

Pada Gambar 3.12 merupakan dudukan nosel yang digunakan untuk meletakan nosel 

agar nosel diam tegak berdiri. 

 

Gambar 3. 12 Dudukan nosel 
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BAB IV 

PENGOLAHAN DATA 

4.1 Data Hasil Eksperimen  

Setelah melakukan eksperimen diperoleh data volume air yang keluar dari nosel yang diukur 

setiap 1 (satu) menit dengan menggunakan gelas ukur. Pada Tabel 4.1 merupakan data hasil 

dari eksperimen. 

Tabel 4. 1 Volume hasil eksperimen 

Tekanan, 

P (psi) 

Waktu (s) Waktu 

rata - 

rata (s) 

Volume (mL) Volume 

rata - 

rata 

(mL) 

Volume 

rata - 

rata (m3) ke-1 ke-2 ke-3 ke-1 ke-2 ke-3 

60 60,17 60,25 60,13 60,18 60 61 60 60,33 6,03E-05 

70 60,12 60,23 60,13 60,16 67 66 65 66,00 6,60E-05 

80 60,22 60,15 60,09 60,15 69 71 69 69,67 6,97E-05 

90 60,02 60,11 60,19 60,11 75 77 78 76,67 7,67E-05 

100 60,10 60,11 60,18 60,13 80 80 81 80,33 8,03E-05 

 

4.1.1 Perhitungan Data Hasil Eksperimen 

Dari hasil eksperimen maka dapat mencari debit air, discharge coefficient, kecepatan dan 

bilangan Reynolds. Pada Tabel 4.2 ialah perhitungan disetiap tekanan dengan mengkonversikan 

satuan psi menjadi Pa. Temperatur yang di dapat merupakan temperatur air saat pengujian, nilai 

massa jenis dan viskositas dynamik di peroleh dari fluida air dengan menggunakan temperatur 

saat pengujian. Diameter inlet dan outlet merupakan diameter nosel ketika fluida masuk nosel 

(inlet) dan fluida keluar nosel (outlet). 

Tabel 4. 2 Parameter yang ditentukan 

Tekanan, 

P 

[Pa] 

Temper

atur, T 

[°C] 

Massa 

jenis, ρ  

[kg/m3] 

Diameter 

inlet, d1 

[m] 

Diameter 

outlet, d2 

[m] 

𝜷4 [d2/d1] 

Viskositas 

dynamik, 

μ 

[kg/ms] 

Luas 

penampan

g outlet, A  

[m2] 

413685,436 23 997,480 1,68E-03 3,00E-04 1,017E-03 9.896E-04 7,069E-08 

482633,009 23 997,480 1,68E-03 3,00E-04 1,017E-03 9.896E-04 7,069E-08 

551580,582 23 997,480 1,68E-03 3,00E-04 1,017E-03 9.896E-04 7,069E-08 

620528,155 23 997,480 1,68E-03 3,00E-04 1,017E-03 9.896E-04 7,069E-08 

689475,727 23 997,480 1,68E-03 3,00E-04 1,017E-03 9.896E-04 7,069E-08 

Dari hasil eksperimen dan parameter yang telah ditentukan maka dapat melakukan perhitungan 

disetiap tekanan untuk mendapatkan debit air, discharge coefficient, kecepatan, dan bilangan 

Reynolds. Berikut perhitungan yang dilakukan di setiap tekanan :  
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 Tekanan 60 psi 

 Mencari debit air (Q) : 

Dengan menggunakan data pada Tabel 4.1 maka dapat memperoleh nilai dari debit air (𝑄1). 

𝑄1 =
𝑉𝑜𝑙1

𝑡1
 

 

Maka, 

𝑄1   =
60,33𝑥10−5

60,18
 

= 1,002𝑥10−6  𝑚
3

𝑠⁄ = 1,002 𝑚𝐿
𝑠⁄ = 3608,773 𝑚𝐿

𝑗𝑎𝑚⁄  

 Mencari discharge coefficient (Cd) : 

Dari hasil debit air (𝑄1) yang telah di dapat dan menggunakan data pada Tabel 4.2 maka dapat 

memperoleh nilai dari discharge coefficient (𝐶𝑑1
). 

𝐶𝑑1
=

𝑄1

𝐴√
2∆𝑃

𝜌(1 − 𝛽4)

 

Maka, 

𝐶𝑑1
=

1,002𝑥10−6

7,069𝑥10−8√
2(413685,436 − 0)

997,480(1 − 1,017𝑥10−3)

  

=
1,002𝑥10−6

7,069𝑥10−8√
2(413685,436)
997,480(0,999)

 

=
1,002𝑥10−6

7,069𝑥10−8√
827370,872

996,483

 

=
1,002𝑥10−6

7,069𝑥10−8√830,291
 

=
1,002𝑥10−6

7,069𝑥10−8(28,815)
 

=
1,002𝑥10−6

2,036𝑥10−6
 

 = 0,492 
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 Mencari kecepatan (v) : 

Dari hasil debit air (𝑄1) yang telah di dapat dan menggunakan data pada Tabel 4.2 maka dapat 

memperoleh nilai dari kecepatan (𝑣1). 

𝑣1 =
𝑄1

𝐴
 

Maka,  

𝑣1    =
1,002𝑥10−6

7,069𝑥10−8
 

   = 14,18 𝑚
𝑠⁄  

 Mencari bilangan Reynold (Re) : 

Dari hasil kecepatan (𝑣1) yang telah di dapat dan menggunakan data pada Tabel 4.2 maka dapat 

memperoleh nilai dari bilangan Reynolds (𝑅𝑒1). 

𝑅𝑒1 =
𝜌. 𝑣1. 𝑑2

𝜇
 

Maka, 

𝑅𝑒1 =
997,480𝑥14,18𝑥3𝑥10−4

9,348𝑥10−4
 

=
4,244

9,348𝑥10−4
 

= 4539,745 

 Tekanan 70 psi 

 Mencari debit air (Q) : 

Dengan menggunakan data pada Tabel 4.1 maka dapat memperoleh nilai dari debit air (𝑄2). 

𝑄2 =
𝑉𝑜𝑙2

𝑡2
 

Maka, 

𝑄2   =
66,00𝑥10−5

60,16
 

= 1,097𝑥10−6  𝑚
3

𝑠⁄ = 1,097 𝑚𝐿
𝑠⁄ = 3949,468 𝑚𝐿

𝑗𝑎𝑚⁄  

 Mencari discharge coefficient (Cd) : 

Dari hasil debit air (𝑄2) yang telah di dapat dan menggunakan data pada Tabel 4.2 maka dapat 

memperoleh nilai dari discharge coefficient (𝐶𝑑2
). 
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𝐶𝑑2
=

𝑄2

𝐴√
2∆𝑃

𝜌(1 − 𝛽4)

 

Maka, 

𝐶𝑑2
=

1,097𝑥10−6

7,069𝑥10−8√
2(482633,009 − 0)

997,480(1 − 1,017𝑥10−3)

 

=
1,097𝑥10−6

7,069𝑥10−8√
2(482633,009)
997,480(0,999)

 

=
1,097𝑥10−6

7,069𝑥10−8√
965266,018

996,483

 

=
1,097𝑥10−6

7,069𝑥10−8√968,673
 

=
1,097𝑥10−6

7,069𝑥10−8(31,124)
 

=
1,097𝑥10−6

2,200𝑥10−6
 

= 0,499 

 Mencari kecepatan (v) : 

Dari hasil debit air (𝑄2) yang telah di dapat dan menggunakan data pada Tabel 4.2 maka dapat 

memperoleh nilai dari kecepatan (𝑣2). 

𝑣2 =
𝑄2

𝐴
 

Maka, 

𝑣2   =
1,097𝑥10−6

7,069𝑥10−8
 

        = 15,52 𝑚
𝑠⁄  

 Mencari bilangan Reynold (Re) : 

Dari hasil kecepatan (𝑣2) yang telah di dapat dan menggunakan data pada Tabel 4.2 maka dapat 

memperoleh nilai dari bilangan Reynolds (𝑅𝑒2). 

𝑅𝑒2 =
𝜌. 𝑣2. 𝑑2

𝜇
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Maka, 

𝑅𝑒2 =
997,480𝑥15,52𝑥3𝑥10−4

9,348𝑥10−4
 

=
4,644

9,348𝑥10−4
 

= 4968,330 

 Tekanan 80 psi 

 Mencari debit air (Q) : 

Dengan menggunakan data pada Tabel 4.1 maka dapat memperoleh nilai dari debit air (𝑄3). 

𝑄3 =
𝑉𝑜𝑙3

𝑡3
 

 

Maka, 

𝑄3   =
69,67𝑥10−5

60,15
 

     = 1,158𝑥10−6  𝑚
3

𝑠⁄ = 1,158 𝑚𝐿
𝑠⁄ = 4169,554 𝑚𝐿

𝑗𝑎𝑚⁄  

 Mencari discharge coefficient (Cd) : 

Dari hasil debit air (𝑄3) yang telah di dapat dan menggunakan data pada Tabel 4.2 maka dapat 

memperoleh nilai dari discharge coefficient (𝐶𝑑3
). 

𝐶𝑑3
=

𝑄3

𝐴√
2∆𝑃

𝜌(1 − 𝛽4)

 

Maka, 

𝐶𝑑3
=

1,158𝑥10−6

7,069𝑥10−8√
2(551580,582 − 0)

997,480(1 − 1,017𝑥10−3)

 

=
1,158𝑥10−6

7,069𝑥10−8√
2(551580,582 )
997,480(0,999)

 

=
1,158𝑥10−6

7,069𝑥10−8√
1103161,164

996,483
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=
1,158𝑥10−6

7,069𝑥10−8√1107,055
 

=
1,158𝑥10−6

7,069𝑥10−8(33,272)
 

=
1,158𝑥10−6

2,352𝑥10−6
 

= 0,492 

 Mencari kecepatan (v) : 

Dari hasil debit air (𝑄3) yang telah di dapat dan menggunakan data pada Tabel 4.2 maka dapat 

memperoleh nilai dari kecepatan (𝑣3). 

𝑣3 =
𝑄3

𝐴
 

Maka, 

𝑣3   =
1,158𝑥10−6

7,069𝑥10−8
 

    = 16,39 𝑚
𝑠⁄  

 Mencari bilangan Reynold (Re) : 

Dari hasil kecepatan (𝑣3) yang telah di dapat dan menggunakan data pada Tabel 4.2 maka dapat 

memperoleh nilai dari bilangan Reynolds (𝑅𝑒3). 

𝑅𝑒3 =
𝜌. 𝑣3. 𝑑2

𝜇
 

Maka, 

𝑅𝑒3 =
997,480𝑥16,39𝑥3𝑥10−4

9,348𝑥10−4
 

=
4,903

9,348𝑥10−4
 

= 5245,181 

 Tekanan 90 psi 

 Mencari debit air (Q) : 

Dengan menggunakan data pada Tabel 4.1 maka dapat memperoleh nilai dari debit air (𝑄4). 

𝑄4 =
𝑉𝑜𝑙4

𝑡4
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Maka, 

𝑄4   =
76,67𝑥10−5

60,11
 

= 1,276𝑥10−6  𝑚
3

𝑠⁄ = 1,276 𝑚𝐿
𝑠⁄ = 4592,036 𝑚𝐿

𝑗𝑎𝑚⁄  

 Mencari discharge coefficient (Cd) : 

Dari hasil debit air (𝑄4) yang telah di dapat dan menggunakan data pada Tabel 4.2 maka dapat 

memperoleh nilai dari discharge coefficient (𝐶𝑑4
). 

𝐶𝑑4
=

𝑄4

𝐴√
2∆𝑃

𝜌(1 − 𝛽4)

 

Maka, 

𝐶𝑑4
=

1,276𝑥10−6

7,069𝑥10−8√
2(620528,155 − 0)

997,480(1 − 1,017𝑥10−3)

 

=
1,276𝑥10−6

7,069𝑥10−8√
2(620528,155 )
997,480(0,999)

 

=
1,276𝑥10−6

7,069𝑥10−8√
1241056,310

996,483

 

=
1,276𝑥10−6

7,069𝑥10−8√1245,437
 

=
1,276𝑥10−6

7,069𝑥10−8(35,291)
 

=
1,276𝑥10−6

2.495𝑥10 −6
 

= 0,511 

 Mencari kecepatan (v) : 

Dari hasil debit air (𝑄4) yang telah di dapat dan menggunakan data pada Tabel 4.2 maka dapat 

memperoleh nilai dari kecepatan (𝑣4). 

𝑣4 =
𝑄4

𝐴
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Maka, 

𝑣4   =
1,276𝑥10−6

7,069𝑥10−8
 

= 18,05 𝑚
𝑠⁄  

 

 Mencari bilangan Reynold (Re) : 

Dari hasil kecepatan (𝑣4) yang telah di dapat dan menggunakan data pada Tabel 4.2 maka dapat 

memperoleh nilai dari bilangan Reynolds (𝑅𝑒4). 

𝑅𝑒4 =
𝜌. 𝑣4. 𝑑2

𝜇
 

Maka, 

𝑅𝑒4 =
997,480𝑥18,05𝑥3𝑥10−4

9,348𝑥10−4
 

=
5,400

9,348𝑥10−4
 

= 5776,665 

 Tekanan 100 psi 

 Mencari debit air (Q) : 

Dengan menggunakan data pada Tabel 4.1 maka dapat memperoleh nilai dari debit air (𝑄5). 

𝑄5 =
𝑉𝑜𝑙5

𝑡5
 

Maka, 

𝑄5   =
80,30𝑥10−5

60,13
 

= 1,336𝑥10 −6  𝑚
3

𝑠⁄ = 1,336 𝑚𝐿
𝑠⁄ = 4809,380 𝑚𝐿

𝑗𝑎𝑚⁄  

 Mencari discharge coefficient (Cd) : 

Dari hasil debit air (𝑄5) yang telah di dapat dan menggunakan data pada Tabel 4.2 maka dapat 

memperoleh nilai dari discharge coefficient (𝐶𝑑5
). 

𝐶𝑑5
=

𝑄5

𝐴√
2∆𝑃

𝜌(1 − 𝛽4)
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Maka, 

𝐶𝑑5
=

1,336𝑥10−6

7,069𝑥10−8√
2(689475,727 − 0)

997,480(1 − 1,017𝑥10−3)

 

=
1,336𝑥10−6

7,069𝑥10−8√
2(689475,727)
997,480(0,999)

 

=
1,336𝑥10−6

7,069𝑥10−8√
1378951,454

996,483

 

=
1,336𝑥10−6

7,069𝑥10−8√1383,818
 

=
1,336𝑥10−6

7,069𝑥10−8(37,200)
 

=
1,336𝑥10−6

2,629𝑥10 −6
 

= 0,508 

 Mencari kecepatan (v) : 

Dari hasil debit air (𝑄5) yang telah di dapat dan menggunakan data pada Tabel 4.2 maka dapat 

memperoleh nilai dari kecepatan (𝑣5). 

𝑣5 =
𝑄5

𝐴
 

Maka, 

𝑣5   =
1,336𝑥10−6

7,069𝑥10−8
 

= 18,90 𝑚
𝑠⁄  

 

 Mencari bilangan Reynold (Re) : 

Dari hasil kecepatan (𝑣5) yang telah di dapat dan menggunakan data pada Tabel 4.2 maka dapat 

memperoleh nilai dari bilangan Reynolds (𝑅𝑒5). 

𝑅𝑒5 =
𝜌. 𝑣5. 𝑑2

𝜇
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Maka, 

𝑅𝑒5 =
997,480𝑥18,90𝑥3𝑥10−4

9,348𝑥10−4
 

=
5,656

9,348𝑥10−4
 

= 6050,077 

4.2 Analisis Numerik 

Dari parameter yang dilakukan pada eksperimen digunakan kembali pada software untuk 

menentukan boundary pada setiap tekanannya, dimana parameter yang digunakan dapat dilihat 

pada Tabel 4.3. 

Tabel 4. 3 Parameter-parameter yang digunakan pada software 

Pengujian 

ke-   

Tekanan 

(psi)  

Diamter 

Inlet, d1 

(mm)  

Diameter 

Outlet, d2 

(mm) 

1 60 

1,68 0,3 

2 70 

3 80 

4 90 

5 100 

4.2.1 Pengukuran Dimensi Nosel  

Dalam penentuan pemodelan geometri fluida nosel, hal pertama yang harus dilakukan adalah 

mengukur geometri nosel. Geometri yang diukur hanya bagian dalam nosel seperti pada gambar 

4.1, karena yang akan dimodelkan oleh Ansys adalah bagian dalam nosel (bagian yang dialiri 

fluida). Pengukuran dimensi nosel dilakukan di Laboratorium Metereologi PT. PINDAD.  

 

Gambar 4. 1 Dimensi nosel 
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4.2.2 Pemodelan Fluida Nosel 

Pada pemodelan fluida nosel hanya memodelkan bagian dalam nosel, yaitu bagian yang dialiri 

fluida. Kemudian memberikan ruang pembatas (opening) berbentuk persegi panjang di ujung 

nosel dimana ruang pembatas tersebut tempat keluarnya fluida dari nosel dengan dimensi 1m x 

0,5m. Dapat dilihat pada gambar 4.2 pemodelan nosel yang dibuat. 

 

Gambar 4. 2 Pemodelan nosel pada analisis numerik 

4.2.3 Hasil Analisis Numerik  

Pada analisis numerik menggunakan software Ansys 16.0 maka didapatkan hasil dari kecepatan 

pada ujung nosel yang dimana hasil tersebut digunakan untuk mencari debit air, discharge 

coefficient, dan bilangan Reynolds pada tekanan 60 psi, 70 psi, 80 psi, 90 psi, dan 100 psi untuk 

dibandingkan dengan hasil dari eksperimen. Berikut adalah hasil dari software disetiap tekanan: 

 

 Tekanan 60 psi 

 

Gambar 4. 3 Hasil analisis pada tekanan 60 psi 

Pada Gambar 4.3 tekanan 60 psi didapatkan hasil kecepatan pada ujung nosel yaitu 29,62 m/s. 
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 Mencari debit air (Q) : 

Dari hasil analisis numerik pada Gambar 4.3 dan menggunakan data pada Tabel 4.3 maka dapat 

memperoleh nilai dari debit air (𝑄1). 

𝑄1 = 𝑣1. 𝐴 

Maka, 

𝑄1   = 29,62𝑥7,069𝑥10−8 

= 2,094𝑥10−6  𝑚
3

𝑠⁄ = 2,094 𝑚𝐿
𝑠⁄ = 7537,372 𝑚𝐿

𝑗𝑎𝑚⁄  

 

 Mencari discharge coefficient (Cd) : 

Dari hasil debit air (𝑄1) yang telah di dapat dan menggunakan data pada Tabel 4.2 maka dapat 

memperoleh nilai dari discharge coefficient (𝐶𝑑1
). 

𝐶𝑑1
=

𝑄1

𝐴√
2∆𝑃

𝜌(1 − 𝛽4)

 

 

Maka, 

𝐶𝑑1
=

2,094𝑥10−6

7,069𝑥10−8√
2(413685,436 − 0)

997,480(1 − 1,017𝑥10−3)

 

=
2,094𝑥10−6

7,069𝑥10−8√
2(413685,436)
997,480(0,999)

 

=
2,094𝑥10−6

7,069𝑥10−8√
827370,872

996,483

 

=
2,094𝑥10−6

7,069𝑥10−8√830,291
 

=
2,094𝑥10−6

7,069𝑥10−8(28,815)
 

=
2,094𝑥10−6

2,037𝑥10−6
 

= 1,028 
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 Mencari bilangan Reynold (Re) : 

Dari hasil kecepatan (𝑣1) yang telah di dapat dan menggunakan data pada Tabel 4.2 maka dapat 

memperoleh nilai dari bilangan Reynolds (𝑅𝑒1). 

𝑅𝑒1 =
𝜌. 𝑣1. 𝑑2

𝜇
 

Maka, 

𝑅𝑒1 =
997,480𝑥29,62𝑥3𝑥10−4

9,348𝑥10−4
 

=
8,864

9,348𝑥10−4
 

= 9481,822 

 Tekanan 70 psi 

 

Gambar 4. 4 Hasil analisis pada tekanan 70 psi 

Pada Gambar 4.4 tekanan 70 psi didapatkan hasil kecepatan pada ujung nosel yaitu 32,24 m/s. 

 Mencari debit air (Q) : 

Dari hasil analisis numerik pada Gambar 4.4 dan menggunakan data pada Tabel 4.3 maka dapat 

memperoleh nilai dari debit air (𝑄2). 

𝑄2 = 𝑣2. 𝐴 

Maka, 

𝑄2   = 32,24𝑥7,069𝑥10−8 

= 2,292𝑥10−6  𝑚
3

𝑠⁄ = 2,292 𝑚𝐿
𝑠⁄ = 8249,885 𝑚𝐿

𝑗𝑎𝑚⁄  
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 Mencari discharge coefficient (Cd) : 

Dari hasil debit air (𝑄2) yang telah di dapat dan menggunakan data pada Tabel 4.2 maka dapat 

memperoleh nilai dari discharge coefficient (𝐶𝑑2
). 

𝐶𝑑2
=

𝑄2

𝐴√
2∆𝑃

𝜌(1 − 𝛽4)

 

 

Maka, 

𝐶𝑑2
=

2,292𝑥10−6

7,069𝑥10−8√
2(482633,009 − 0)

997,480(1 − 1,017𝑥10−3)

 

=
2,292𝑥10−6

7,069𝑥10−8√
2(482633,009)
997,480(0,999)

 

=
2,292𝑥10−6

7,069𝑥10−8√
965266,018

996,483

 

=
2,292𝑥10−6

7,069𝑥10−8√968,673
 

=
2,292𝑥10−6

7,069𝑥10−8(31,124)
 

=
2,292𝑥10−6

2,200𝑥10−6
 

= 1,042 

 Mencari bilangan Reynold (Re) : 

Dari hasil kecepatan (𝑣2) yang telah di dapat dan menggunakan data pada Tabel 4.2 maka dapat 

memperoleh nilai dari bilangan Reynolds (𝑅𝑒2). 

𝑅𝑒2 =
𝜌. 𝑣2. 𝑑2

𝜇
 

Maka, 

𝑅𝑒2 =
997,480𝑥32,24𝑥3𝑥10−4

9,348𝑥10−4
 

=
9,701

9,348𝑥10−4
 

= 10378,146 
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 Tekanan 80 psi 

 

Gambar 4. 5 Hasil analisis pada tekanan 80 psi 

Pada Gambar 4.5 tekanan 80 psi didapatkan hasil kecepatan pada ujung nosel yaitu 34,06 m/s. 

 Mencari debit air (Q) : 

Dari hasil analisis numerik pada Gambar 4.5 dan menggunakan data pada Tabel 4.3 maka dapat 

memperoleh nilai dari debit air (𝑄3). 

𝑄3 = 𝑣3. 𝐴 

Maka, 

𝑄3   = 34,06𝑥7,069𝑥10−8 

= 2,408𝑥10−6  𝑚
3

𝑠⁄ = 2,408 𝑚𝐿
𝑠⁄ = 8667,214 𝑚𝐿

𝑗𝑎𝑚⁄  

 

 Mencari discharge coefficient (Cd) : 

Dari hasil debit air (𝑄3) yang telah di dapat dan menggunakan data pada Tabel 4.2 maka dapat 

memperoleh nilai dari discharge coefficient (𝐶𝑑3
). 

𝐶𝑑3
=

𝑄3

𝐴√
2∆𝑃

𝜌(1 − 𝛽4)

 

 

Maka, 

𝐶𝑑3
=

2,408𝑥10−6

7,069𝑥10−8√
2(551580,582 − 0)

997,480(1 − 1,017𝑥10−3)
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=
2,408𝑥10−6

7,069𝑥10−8√
2(551580,582 )
997,480(0,999)

 

=
2,408𝑥10−6

7,069𝑥10−8√
1103161,164

996,483

 

=
2,408𝑥10−6

7,069𝑥10−8√1107,055
 

=
2,408𝑥10−6

7,069𝑥10−8(33,272)
 

=
2,408𝑥10−6

2,352𝑥10−6
 

= 1,024 

 Mencari bilangan Reynold (Re) : 

Dari hasil kecepatan (𝑣3) yang telah di dapat dan menggunakan data pada Tabel 4.2 maka dapat 

memperoleh nilai dari bilangan Reynolds (𝑅𝑒3). 

𝑅𝑒3 =
𝜌. 𝑣3. 𝑑2

𝜇
 

Maka, 

𝑅𝑒3 =
997,480𝑥34,06𝑥3𝑥10−4

9,348𝑥10−4
 

=
10,192

9,348𝑥10−4
 

= 10903,135 

 Tekanan 90 psi 

 

Gambar 4. 6 Hasil analisis pada tekanan 90 psi 

Pada Gambar 4.6 tekanan 90 psi didapatkan hasil kecepatan pada ujung nosel yaitu 36,01 m/s. 
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 Mencari debit air (Q) : 

Dari hasil analisis numerik pada Gambar 4.6 dan menggunakan data pada Tabel 4.3 maka dapat 

memperoleh nilai dari debit air (𝑄4). 

𝑄4 = 𝑣4. 𝐴 

Maka, 

𝑄4  = 36,01𝑥7,069𝑥10−8 

= 2,520𝑥10−6  𝑚
3

𝑠⁄ = 2,520 𝑚𝐿
𝑠⁄ = 9071,820 𝑚𝐿

𝑗𝑎𝑚⁄  

 

 Mencari discharge coefficient (Cd) : 

Dari hasil debit air (𝑄4) yang telah di dapat dan menggunakan data pada Tabel 4.2 maka dapat 

memperoleh nilai dari discharge coefficient (𝐶𝑑4
). 

𝐶𝑑4
=

𝑄4

𝐴√
2∆𝑃

𝜌(1 − 𝛽4)

 

 

Maka, 

𝐶𝑑4
=

2,520𝑥10−6

7,069𝑥10−8√
2(620528,155 − 0)

997,480(1 − 1,017𝑥10−3)

 

=
2,520𝑥10−6

7,069𝑥10−8√
2(620528,155 )
997,480(0,999)

 

=
2,520𝑥10−6

7,069𝑥10−8√
1241056,310

996,483

 

=
2,520𝑥10−6

7,069𝑥10−8√1245,437
 

=
2,520𝑥10−6

7,069𝑥10−8(35,291)
 

=
2,520𝑥10−6

2,495𝑥10−6
 

= 1,010 
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 Mencari bilangan Reynold (Re) : 

Dari hasil kecepatan (𝑣4) yang telah di dapat dan menggunakan data pada Tabel 4.2 maka dapat 

memperoleh nilai dari bilangan Reynolds (𝑅𝑒4). 

𝑅𝑒4 =
𝜌. 𝑣4. 𝑑2

𝜇
 

Maka, 

𝑅𝑒4 =
997,480𝑥35,65𝑥3𝑥10−4

9,348𝑥10−4
 

=
10,668

9,348𝑥10−4
 

= 11412,119 

 Tekanan 100 psi 

 

Gambar 4. 7 Hasil analisis pada tekanan 100 psi 

Pada Gambar 4.7 tekanan 100 psi didapatkan hasil kecepatan pada ujung nosel yaitu 37,94 m/s.  

 Mencari debit air (Q) : 

Dari hasil analisis numerik pada Gambar 4.7 dan menggunakan data pada Tabel 4.3 maka dapat 

memperoleh nilai dari debit air (𝑄5). 

𝑄5 = 𝑣5. 𝐴 

Maka, 

𝑄5   = 37,94𝑥7,069𝑥10−8 

= 2,682𝑥10−6  𝑚
3

𝑠⁄ = 2,682 𝑚𝐿
𝑠⁄ = 9654,554 𝑚𝐿

𝑗𝑎𝑚⁄  
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 Mencari discharge coefficient (Cd) : 

Dari hasil debit air (𝑄5) yang telah di dapat dan menggunakan data pada Tabel 4.2 maka dapat 

memperoleh nilai dari discharge coefficient (𝐶𝑑5
). 

𝐶𝑑5
=

𝑄5

𝐴√
2∆𝑃

𝜌(1 − 𝛽4)

 

 

Maka, 

𝐶𝑑5
=

2,682𝑥10−6

7,069𝑥10−8√
2(689475,727 − 0)

997,480(1 − 1,017𝑥10−3)

 

=
2,682𝑥10−6

7,069𝑥10−8√
2(689475,727)
997,480(0,999)

 

=
2,682𝑥10−6

7,069𝑥10−8√
1378951,454

996,483

 

=
2,682𝑥10−6

7,069𝑥10−8√1383,818
 

=
2,682𝑥10−6

7,069𝑥10−8(37,200)
 

=
2,682𝑥10−6

2,629𝑥10−6
 

= 1,020 

 Mencari bilangan Reynold (Re) : 

Dari hasil kecepatan (𝑣5) yang telah di dapat dan menggunakan data pada Tabel 4.2 maka dapat 

memperoleh nilai dari bilangan Reynolds (𝑅𝑒5). 

𝑅𝑒5 =
𝜌. 𝑣5. 𝑑2

𝜇
 

Maka, 

𝑅𝑒5 =
997,480𝑥37,94𝑥3𝑥10−4

9,348𝑥10−4
 

=
11,353

9,348𝑥10−4
 

= 12145,183  
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BAB V 

ANALISA  

5.1 Hasil Eksperimen dan Numerik 

Pada hasil eksperimen dan numerik sudut yang didapat dilakukan dengan menarik garis lurus 

dari ujung nosel tersebut. Berikut adalah hasil dari foto yang diambil pada eksperimen dan hasil 

kajian numerik pada setiap tekanan, yaitu : 

 Tekanan 60 psi 

 

Gambar 5. 1 Hasil eksperimen dan numerik tekanan 60 psi 

Pada Gambar 5.1 sudut semprotan yang didapat pada eksperimen yaitu 34,992° sedangkan pada 

hasil numerik sudut yang didapatkan yaitu 36,147°. 

 Tekanan 70 psi 

 

Gambar 5. 2 Hasil eksperimen dan numerik tekanan 70 psi 



46 

 

Pada Gambar 5.2 sudut semprotan yang didapat pada eksperimen yaitu 36,670° sedangkan pada 

hasil numerik sudut yang didapatkan yaitu 37,376°. 

 Tekanan 80 psi 

 

Gambar 5. 3 Hasil eksperimen dan numerik tekanan 80 psi 

Pada Gambar 5.3 sudut semprotan yang didapat pada eksperimen yaitu 37,128° sedangkan pada 

hasil numerik sudut yang didapatkan yaitu 38,0854°. 

 Tekanan 90 psi 

 

Gambar 5. 4 Hasil eksperimen dan numerik tekanan 90 psi 
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Pada Gambar 5.4 sudut semprotan yang didapat pada eksperimen yaitu 37,939° sedangkan pada 

hasil numerik sudut yang didapatkan yaitu 38,785°. 

 Tekanan 100 psi 

 

Gambar 5. 5 Hasil eksperimen dan numerik tekanan 100 psi 

Pada Gambar 5.5 sudut semprotan yang didapat pada eksperimen yaitu 38,385° sedangkan pada 

hasil numerik sudut yang didapatkan yaitu 39,352°. 

 

Dari hasil eksperimen dan numerik maka didapatkan bahwa sudut semprotan semakin 

meningkat, faktor tersebut dikarenakan luas penampang yang tetap sama tetapi tekanan 

berubah-ubah. Perbedaan pada hasil eksperimen dan numerik dikarenakan pada analisis 

numerik ada asumsi yang di abaikan salah satu contoh gesekan fluida pada nosel sehingga 

tekanan tetap dan hasil semprotan lebih besar saat keluar nosel sehingga sudut yang didapatkan 

lebih besar dari eksperimen. 

5.1.1 Kecepatan 

Dari hasil perhitungan eksperimen dan analisis numerik dibuat grafik pada microsoft excel dan 

menggunakan persamaan regresi linear agar mengetahui penyimpangan dan hubungan antara 

kecepatan eksperimen dan kecepatan Ansys cfx dapat dilihat pada Gambar 5.6 .  
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Gambar 5. 6 Grafik perbandingan kecepatan eksperimen terhadap kecepatan Ansys CFX 

Pada Gambar 5.6 menunjukan bahwa 𝑦 = 1.6438𝑥 + 6.6404, nilai dari 1.6438 menunjukan 

bahwa nilai koefisien pada kecepatan dan bertanda positif menyatakan hasil dari kecepatan 

terus meningkat sedangkan variable 𝑥 merupakan nilai dari sumbu x atau vexp. Intercept 6.6404 

merupakan penyimpangan yang terjadi antara kecepatan pada eksperimen dan kecepatan Ansys 

cfx, penyimpangan tersebut terjadi karena geometri pada nosel tidak menyerupai dengan nosel 

aslinya. Koefisien korelasi (R2) menunjukan hubungan antara variable 𝑥 dan variable 𝑦, nilai 

yang didapat pada perbandingan kecepatan sebesar 0.9775 yaitu menjukan hubungan antara 

kecepatan eksperimen dan kecepatan Ansys cfx, hubungan tersebut dapat dilihat dari hasil 

kecepatan pada eksperimen maupun pada Ansys cfx yang nilainya terus meningkat di setiap 

tekanan. 

5.1.2 Debit Air 

Dari hasil perhitungan eksperimen dan analisis numerik dibuat grafik pada microsoft excel dan 

menggunakan persamaan regresi linear agar mengetahui penyimpangan dan hubungan antara 

debit air eksperimen dan debit air Ansys cfx dapat dilihat pada Gambar 5.7.  

y = 1.6438x + 6.6404
R² = 0.9775
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Gambar 5. 7 Grafik perbandingan debit eksperimen terhadap debit Ansys CFX 

Pada Gambar 5.7 menunjukan bahwa 𝑦 = 1.6438𝑥 + 1689.8, nilai dari 1.6438 menunjukan 

bahwa nilai koefisien pada debit air dan bertanda positif menyatakan hasil dari debit air terus 

meningkat sedangkan variable 𝑥 merupakan nilai dari sumbu x atau Qexp. Intercept 1689.8 

merupakan penyimpangan yang terjadi antara debit air pada eksperimen dan debit air Ansys 

cfx, penyimpangan tersebut terjadi karena geometri pada nosel tidak menyerupai dengan nosel 

aslinya. Koefisien korelasi (R2) menunjukan hubungan antara variable 𝑥 dan variable 𝑦, nilai 

yang didapat pada perbandingan debit air sebesar 0.9775 yaitu menunjukan hubungan antara 

debit air eksperimen dan debit air Ansys cfx, hubungan tersebut dapat dilihat dari hasil debit 

air pada eksperimen maupun pada Ansys cfx yang nilainya terus meningkat di setiap tekanan. 

5.1.3 Bilangan Reynold 

Dari hasil perhitungan eksperimen dan analisis numerik dibuat grafik pada microsoft excel dan 

menggunakan persamaan regresi linear agar mengetahui penyimpangan dan hubungan antara 

bilangan Reynold eksperimen dan bilangan Reynold Ansys cfx dapat dilihat pada Gambar 5.8.  

y = 1.6438x + 1689.8
R² = 0.9775
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Gambar 5. 8 Grafik perbandingan Re eksperimen terhadap Re Ansys CFX 

Pada Gambar 5.8 menunjukan bahwa 𝑦 = 1.6438𝑥 + 1842, nilai dari 1.6438 menunjukan 

bahwa nilai koefisien pada bilangan Reynold dan bertanda positif menyatakan hasil dari 

bilangan Reynold terus meningkat sedangkan variable 𝑥 merupakan nilai dari sumbu x atau 

Reexp. Intercept 1842 merupakan penyimpangan yang terjadi antara bilangan Reynold pada 

eksperimen dan bilangan Reynold Ansys cfx, penyimpangan tersebut terjadi karena geometri 

pada nosel tidak menyerupai dengan nosel aslinya. Koefisien korelasi (R2) menunjukan 

hubungan antara variable 𝑥 dan variable 𝑦, nilai yang didapat pada perbandingan bilangan 

Reynold sebesar 0.9775 yaitu menunjukan hubungan antara bilangan Reynold eksperimen dan 

bilangan Reynold Ansys cfx, hubungan tersebut dapat dilihat dari hasil bilangan Reynold pada 

eksperimen maupun pada Ansys cfx yang nilainya terus meningkat di setiap tekanan. 

5.1.4 Discharge Coefficient 

Dari hasil perhitungan eksperimen dan analisis numerik dibuat grafik pada microsoft excel dan 

menggunakan persamaan regresi linear agar mengetahui penyimpangan dan hubungan antara 

discharge coefficient eksperimen dan discharge coefficient Ansys cfx dapat dilihat pada gambar 

5.9. 

y = 1.6438x + 1842
R² = 0.9775
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Gambar 5. 9 Grafik perbandingan discharge coefficient eksperimen terhadap discharge 

coefficient Ansys CFX 

Pada Gambar 5.9 menunjukan bahwa 𝑦 = −0.7799𝑥 + 1.4153, nilai dari 0.7799 menunjukan 

bahwa nilai koefisien pada discharge coefficient dan bertanda negatif (-) menyatakan hasil dari 

discharge coefficient terjadi penurunan sedangkan variable 𝑥 merupakan nilai dari sumbu x 

atau Cdexp. Intercept 1.4153 merupakan penyimpangan yang terjadi antara discharge 

coefficient pada eksperimen dan discharge coefficient Ansys cfx, penyimpangan tersebut terjadi 

karena geometri pada nosel tidak menyerupai dengan nosel aslinya. Koefisien korelasi (R2) 

menunjukan hubungan antara variable 𝑥 dan variable 𝑦, nilai yang didapat pada perbandingan 

discharge coefficient sebesar 0.3562 yaitu menunjukan hubungan antara discharge coefficient 

eksperimen dan discharge coefficient Ansys cfx, hubungan tersebut dapat dilihat dari hasil 

discharge coefficient pada eksperimen maupun pada Ansys cfx yang nilainya tak tentu atau 

terjadi penurunan. 
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BAB VI 

KESIMPULAN DAN SARAN 

6.1 Kesimpulan 

1. Pengaruh tekanan pada karakteristik aliran fluida, yaitu : 

• Debit air yang didapatkan pada setiap tekanan terus meningkat karena nosel yang 

digunakan tetap sama. 

• Kecepatan yang didapatkan pada setiap tekanan terus meningkat karena debit air 

yang terus meningkat. 

• Hasil perhitungan bilangan Reynold meningkat dikarenakan kecepatan yang didapat 

terus meningkat. 

• Discharge coefficient didapatkan tak ada perbedaan yang signifikan dikarenakan 

nosel yang digunakan tetap sama. 

2. Bilangan Reynold, debit air, dan Cd yang didapatkan pada setiap tekanan terus 

meningkatkan. Hasil numerik lebih besar dibandingkan hasil eksperimen.   

Tekanan 
Re Debit Air Cd 

 EXP CFX  EXP CFX  EXP CFX 

60 4539.745 9481.822 3608.773 7537.372 0.492 1.028 

70 4968.330 10378.146 3949.468 8249.885 0.499 1.042 

80 5245.181 10903.135 4169.544 8667.214 0.492 1.024 

90 5776.665 11412.119 4592.036 9071.820 0.511 1.010 

100 6050.077 12145.183 4809.380 9654.554 0.508 1.020 

Perbedaan yang terjadi dari hasil eksperimen dan numerik, karena faktor geometri 

pemodalan pada ansys tidak menyerupai benda aslinya, pada analisis cfx gesekan dan 

kebocoran pada selang di eksperimen di abaikan di cfx. 

6.2 Saran 

• Nosel yang digunakan seharusnya dipotong untuk melihat isi dari nosel tersebut agar 

geometri yang dimodelkan sama seperti eksperimen. 

• Ketika akan pengujian sebaiknya dilakukan pada ruangan tertutup agar hasil 

semprotan tidak dipengaruhi oleh udara sekitar. 
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LAMPIRAN 
  



 

1. Tabel Physical Properties of Water 

 

 
  



 

2. Langkah-langkah Simulasi Numerik  

Hal pertama yang dilakukan adalah : 

• Pilih menu Star dari windows program manager. 

• Lalu pilih All program, Ansys 16.0, Workbrench 16.0. 

Setelah langkah diatas dilakukan maka keluar seperti pada Gambar 1. 

 
Gambar 1 Tampilan Awal Ansys 

 

 

Menggunakan Fluid Flow (CFX) dengan langkah, Menu Toolbox > Fluid Flow (CFX), dapat 

dilihat pada Gambar 2. Nomor 2 merupakan hasil dari nomor 1 dan menunjukan proses untuk 

menganalisis aliran fluida. 

 
Gambar 2 Menampilkan Ansys CFX. 



 

a. Geometry 

 Menampilkan Geometry dengan cara klik 2x pada Geometry seperti pada Gambar 3. 

 

Gambar 3 Geometry 

 Tampilan awal pada Geometry dapat dilihat pada Gambar 4. 

 

Gambar 4 Tampilan Awal Geometry 



 

 Memilih satuan yang dibutuhkan dengan langkah pada Geometry Main Menu > 

Units > Milimeter dapat dilihat seperti Gambar 5. 

 

Gambar 5 Memilih Satuan Pada Geometry 

 Model nosel sudah digambarkan menggunakan software Autodesk Inventor 2015 

dengan format gambar .stp, maka pada Geometry  hanya melakukan import dari hasil 

Autodesk Inventor 2015 seperti pada Gambar 6. Dengan langkah Geometry Main 

Menu klik File > Import External Geometry File… 

 

Gambar 6 Import External Geometry File 

 Setelah melakukan Import External Geometry File… dapat dilihat pada Gambar 7 

nomor 3, langkah berikutnya Geometry main menu klik Generate seperti pada nomor 

4. 



 

 

Gambar 7 Generate 

 Pada Gambar 8 merupakan hasil dari Generate pada Import External Geometry 

File…  

 

Gambar 8 Generate Hasil Import 

 Membuat New Plane untuk aliran fluida pada nosel dengan langkah arahkan cursor 

pada pada gambar Geometry ketika fluida akan masuk/ inlet fluida lalu klik hingga 



 

berwarna hijau lalu pada menu klik New Sketch seperti pada Gambar 9 ditunjukan 

oleh nomor 5. 

 

Gambar 9 Membuat New Plane Untuk Arah Aliran Fluida 

 Pada Gambar 10 merupakan hasil dari New Plane menunjukan sumbu arah pada inlet 

fluida ditunjukan pada nomor 6, lalu Reverse Normal/Z-Aksis di ganti menjadi Yes 

agar arah kordinat menunjukan aliran yang masuk pada nomor 7, setelah langkah 6 

dan 7 selesai lalu klik Generate seperti yang ditunjukan pada nomor 8. 

 

Gambar 10 Hasil New Plane 



 

 Pada Gambar 11 merupakan cara untuk membuat Sketch pada New Plane dengan 

langkah klik pada Main Menu > Sketching seperti yang ditunjukan pada nomor 9, 

lalu membuat lingkaran pada Sketching Toolbox > Circle seperti pada nomor 10, 

setelah memilih Circle  lalu arahkan pada Center New Plane seperti yang ditunjukan 

nomor 11. Untuk mengganti ukuran atau Dimensions klik Sketching Toolbox > 

Dimensions seperti yang ditunjukan nomor 12.  

 

Gambar 11 Membuat Sketch pada Newe Plane 

 Setelah Sketch dibuat, lalu pada Main Menu > Extrude seperti pada gambar 12. 

 

Gambar 12 Extrude Sketch 



 

 Setelah di klik Extrude, pada tabel Details of Extrude, pada kolom Geometry klik 

Apply seperti pada nomor 13, lalu untuk ukuran jarak fluida dari fluida masuk (inlet) 

– fluida keluar (outlet) dimasukan 24.65mm pada kolom FD1, Depth (>0) ditunjukan 

pada nomor 14. Setelah selesai lalu Generate seperti pada nomor 15 dapat dilihat 

pada Gambar 13. 

 

Gambar 13 Setting Extrude 

 Setelah di Extrude, lalu membuat alur pada aliran fluida dengan langkah, Main Menu 

> Create > Boolean dapat dilihat pada Gambar 14.  

 

Gambar 14 Membuat Alur Fluida Menggunakan Boolean 



 

 Pada tabel Details View ditunjukan pada nomor 16, pada kolom Operation di ganti 

menjadi Subtarct, lalu pada Target Bodies gerakan klik pada Geometry hasil dari 

Extrude, dan pada Tool Bodies klilk pada Geometry Nosel. Setelah selesai Setting 

Boolean lalu klik Generate ditunjukan pada nomor 17 dapat dilihat pada Gambar 15. 

 

Gambar 15 Setting Boolean 

 Pada Gambar 16 merupakan hasil dari Boolean, alur aliran fluida pada nosel dilihat 

pada koordinat x. 

 

Gambar 16 Alur Aliran Fluida pada Nosel 

 



 

 Pada Gambar 17 merupakan cara untuk menggambungkan alur aliran fluida dengan 

ruangan terbuka atau Opening dengan langkah Main Menu > Create > Boolean 

seperti pada Gambar 14. Lalu pada Details View pada nomor 18, kolom Operation 

diubah menjadi Unite dan pada Tool Bodies klik alur aliran fluida dan ruangan 

terbuka atau Opening lalu Apply maka didapatkan 2 Bodies pada Tool Bodies seperti 

pada Gambar 17. Setelah selesai lalu Generate seperti yang ditunjukan nomor 19. 

 

Gambar 17 Menggambungkan Alur Aliran Fluida pada Nosel dan Ruangan Terbuka 

 Setelah digabungkan dan part menjadi 1 Body, klik pada Part 1 seperti pada nomor 

20  lalu pada Details of Body kolom Fluid/Solid di ganti menjadi Fluid dapat dilihat 

pada Gambar 18 dan ditunjukan nomor 21. 

 

Gambar 18 Mengganti Part Menjadi Fluid 



 

 Untuk mengatur lokasi fluida ketika awal masuk klik kiri pada bagian awal nosel lalu 

klik kanan dan pilih Named Selection dapat dilihat pada Gambar 19,  masukan nama 

Input pada Named Selection pada tabel Details of Named Sel1, setelah selesai lalu 

Generate dapat dilihat pada Gambar 20.  

 

Gambar 19 Named Selection Input 

 

Gambar 20 Memberi Nama pada Lokasi yang Dipilih 

 

 



 

 Untuk mengatur lokasi ruangan terbuka klik kiri+CTRL pada 5 bagian bujur sangkar 

yang tidak kontak langsung pada nosel, lalu klik kanan dan pilih Named Selection 

dapat dilihat pada Gambar 21,  masukan nama Open pada Named Selection pada 

tabel Details of Named Sel1, setelah selesai lalu Generate dapat dilihat pada Gambar 

22.  

 

Gambar 21 Named Selection Open 

 

Gambar 22 Memberi Nama pada Lokasi yang Dipilih 

 

 



 

b. Mesh 

 Menampilkan Mesh dengan cara klik 2x pada Mesh dapat dilihat pada Gambar 23 

 

Gambar 23 Mesh 

 Pada Gambar 24 merupakan tampilan awal pada Mesh 

 

Gambar 24 Tampilan awal Mesh 



 

 Untuk melakukan Mesh klik pada kolom Project Mesh seperti pada nomor 22, lalu 

pada tabel Display of “Meshing” kolom Default pada bagian Pyshic Perference 

diganti menjadi CFD lalu pada bagian Solver Preference diganti menjadi CFX. 

Setelah di atur pada tabel Display of “Meshing” lalu tahapan berikutnya adalah 

Update seperti pada nomor 24 dapat dilihat pada Gambar 25. 

 

Gambar 25 Mengatur Mesh 

 Setelah mengatur pada tabel Display of “Meshing” lalu mengatur ukuran Mesh pada 

ujung nosel dengan cara pada Menu Mesh > Mesh Control > Sizing dapat dilihat 

pada Gambar 26. 

 

Gambar 26 Mengatur Sizing Mesh 



 

 Setelah dipilih menu Sizing lalu mengatur pada tabel Details of “Sizing” – Sizing 

ditunjukan pada Gambar 27 nomor 25, pada kolom Scope mengatur Geometry klik 

pada bagian ujung nosel ditunjukan pada nomor 26. Lalu ukuran mesh diatur pada 

kolom Type Element Setting dan ukuran Element Size sebesar 0.05mm. Setelah di 

atur pada tabel Details of “Sizing” – Sizing, lalu Update. 

 

Gambar 27 Mengatur Sizing Mesh pada Ujung Nosel 

 Untuk melihat hasil pada Sizing klik Mesh pada Project seperti pada Gambar 28. 

Gambar 28 Hasil Sizing pada Ujung Nosel 

 

 



 

c. Setup 

 Menampilkan Geometry dengan cara klik 2x pada Setup seperti Gambar 29. 

 

Gambar 29 Setup 

 Pada Gambar 30 merupakan tampilan awal pada Setup  

 

Gambar 30 Tampilan Awal Setup 



 

 Untuk mengatur Default Domain, klik 2x pada Default Domain dapat dilihat pada 

Gambar 31.  

 

Gambar 31 Mengeluarkan Menu Default Domain 

 Tahap berikutnya mengatur Details of Default Domain in Flow Analysys 1 pada tab 

Basic Settings, untuk mengatur fluida yang diinginkan pada Fluid and Perticle 

Definitions… klik Fluid 1 > Remove Select Item   dapat dilihat pada Gambar 32. 

 

Gambar 32 Mengatur Fluida 



 

 Setelah di Remove fluida 1, lalu Add New Item  tuliskan nama fluida Air dan 

Water seperti pada Gambar 33, lalu Fluida pada Air dipilih material Air at 25oC dan 

Fluida pada Water dipilih material Water dan pada Morphology dipilih Despersed 

Fluid lalu Mean Diameter dimasukan 0.5micron, pada kedua fluida tersebut 

Reference Preassure dimasukan 1atm dapat dilihat pada gambar 34 (1) dan 34 (2). 

 

Gambar 33 Name Fluid Domain 

 

(1)  (2) 

Gambar 34 (1) Mengatur Fluida Air, (2) Mengatur Fluida Water 

 

 

 

 

 

 

 

 



 

 

 Setelah mengatur fluida yang digunakan lalu masih tetap pada pengaturan Default 

Domain ganti bar untuk mengatur spesifikasi fluida yang di gunakan dengan cara 

Fluid Specific Models > Option  > Shear Stress Transport dapat dilihat pada 

Gambar 35. 

 

Gambar 35 Mengatur Fluid Specific Model 

 Lalu membuat Boundary atau kondisi batas pada fluida dengan cara Klik Default 

Domain lalu pilih Insert > Boundary seperti Gambar 36. 

 

Gambar 36 Membuat Boundary Inlet 

 Setelah itu akan keluar menu bar Insert Boundary untuk memberikan nama pada 

Boundary yang akan di buat, kemudian klik pada kotak Name ketik Inlet > Ok dapat 

di lihat pada Gambar 37. 

 

Gambar 37 Memberi Nama Boundary Inlet 



 

 Setelah membuat nama pada Boundary klik kanan pada Inlet  > Edit dapat di lihat 

pada Gambar 38. 

 

Gambar 38 Mengatur Inlet 

 Untuk memberikan Boundary Condition klik Basic Setting lalu pada kolom 

Boundary Type pilih Inlet dapat di lihat pada Gambar 39. 

 

Gambar 39 Memilih Boundary Type 

 

 



 

 Setelah memilih Boundary Type lalu mengatur Location pada Boundary dengan cara 

pada kolom Location pilih Inlet (pada pilihat inlet ini telah di atur pada Gambar 20) 

seperti pada Gambar 40. 

 

Gambar 40 Memilih Location Boundary 

 Langkah berikutnya mengatur Boundary : Inlet dengan cara pada Boundary Details 

pada menu Mass and Mommentum Option > Total Pressure (Stable), lalu pada 

Relative Pressure tuliskan besar tekanan yang akan digunakan yaitu sebesar 60 psi, 

lalu pada menu Turbulance Option > High (Intensity = 10%) dapat dilihat pada 

Gambar 41. 

 

Gambar 41 Mengatur Boundary Condition 



 

 

 Langkah berikutnya mengatur Fluid Values pada menu Boundary Condition klik Air 

lalu pada menu Volume Fraction masukan angka 0 untuk menunjukan fraksi pada 

nosel tidak ada Air atau udara seperti pada Gambar 42 (1). Berikutnya mengatur 

Water pada menu Volume Fraction masukan angka 1 untuk menunjukan fraksi pada 

nosel terisi Water atau air seperti pada Gambar 42 (2). 

 

(1)              (2)   

Gambar 42 (1) Mengatur Fluid Values Air (2) Mengatur Fluid Values Water 

 Setelah selesai membuat Boundary Condition Domain Inlet, selanjunya membuat 

Domain Opening dengan cara Klik Default Domain lalu pilih Insert > Boundary. 

 

Gambar 43 Membuat Boundary Opening 

 Setelah itu akan keluar menu bar Insert Boundary untuk memberikan nama pada 

Boundary yang akan di buat, kemudian klik pada kotak Name ketik Opening > Ok 

dapat di lihat pada Gambar 44. 



 

 

Gambar 44 Memberi Nama Boundary Opening 

 Setelah membuat nama pada Boundary klik kanan pada Opening > Edit dapat di lihat 

pada Gambar 45. 

 

Gambar 45 Mengatur Opening 

 Untuk memberikan Boundary Condition klik Basic Setting lalu pada kolom 

Boundary Type pilih Opening dan Location yang dipilih Opening dapat di lihat pada 

Gambar 46. 

 

Gambar 46 Memilih Boundary Type dan Location 



 

 Langkah berikutnya mengatur Boundary : Opening dengan cara pada Boundary 

Details pada menu Mass and Mommentum Option > Opening Pres. And Dim lalu 

pada Relative Pressure tuliskan besar tekanan yang akan digunakan yaitu sebesar 0 

psi, lalu pada menu Turbulance Option > High (Intensity = 10%) dapat dilihat pada 

Gambar 47. 

 

Gambar 47 Mengatur Boundary Condition 

 Langkah berikutnya mengatur Fluid Values pada menu Boundary Condition klik Air 

lalu pada menu Volume Fraction masukan angka 1 untuk menunjukan fraksi pada 

Opening atau hanya ada udara sekitar pada Gambar 42 (1). Berikutnya mengatur 

Water pada menu Volume Fraction masukan angka 0 untuk menunjukan fraksi pada 

Opening tidak ada air seperti pada Gambar 42 (2). 

 

(1)                (2) 

Gambar 48 (1) Mengatur Fluid Values Air (2) Mengatur Fluid Values Water 



 

 Setelah mengatur Boundary Condition lalu mengatur Solver Control untuk waktu 

Interation pada saat Running Kemudian klik kanan pada solver control dengan cara 

klik kanan pada Solver Control > Edit seperti pada Gambar 49. 

 

Gambar 49 Edit Solver Control 

 

 Setelah masuk pada menu Solver Control lalu pada menu bat Basic Setting pada 

kolom Convergence Control di Min. Iteration masukan angka 1 dan Max. Iteration 

masukan angka 1000 kemudian setelah selesai klik Apply dan Ok dapat di lihat pada 

Gambar 50. 

 

Gambar 50 Mengatur Solver Control 



 

 

 

 

d. Solution 

 Setelah selesai mengatur pada Setup lalu Close Setup dan masuk pada bagian 

selanjutnya yaitu Solution dengan cara klik 2x pada Solution dapat di lihat pada 

Gambar 51. 

 

 

Gambar 51 Solution 

. 

 Setelah klik Solution, maka akan keluar Define Run  Kemudian klik Start Run lalu 

tunggu sampai Running selesai dapat di lihat pada Gambar 52. 

 

Gambar 52 Mengatur Running 

 

 

 



 

 

 

 

e. Results 

 Setelah Running selesai lalu Close Running dan masuk pada bagian selanjutnya 

yaitu Results dengan cara klik 2x pada Results dapat di lihat pada Gambar 51. 

 

Gambar 53 Results 

 Berikutnya setelah masuk pada Results kemudian klik Insert > Location > Plane. 

Maka akan keluar menu Plane  pada User Location and Plot dapat di lihat pada 

Gambar 54. 

 

Gambar 54 Masuk Pada Menu Plane 

 Kemudian klik dua kali pada Plane 1, maka akan keluar menu Details of Plane 1 

pada menu Geomtry > Definiton > Method pilih YZ Plane agar plane hanya 

menunjukan pandangan pada kordinat Y dan Z. Dapat di lihat pada Gambar 55. 



 

 

Gambar 55 Mengatur Details of Plane 1 

 Setelah Geomtry telah di atur lalu klik pada menu bar Color > Mode pilih Variable, 

kemudian pada Variable pilih Water Velocity agar Results menunjukan hasil pada 

kecepatan fluida, berikutnya pada Color Map pilih Rainbow agar warna yang keluar 

banyak macamnya sehingga menunjukan perbedaan kecepatan yang didapat di setiap 

titik tertentu, berikutnya klik Apply dapat di lihat pada Gambar 56. 

 

Gambar 56 Mengatur Color Pada Plane 

 

 



 

 Setelah mengatur Plane maka akan keluar hasil  dari Analisa yang telah di lakukan, 

maka selesai dapat di lihat pada Gambar 57. Untuk memplot pada hasil tekanan yang 

lain dapat melakukan dengan cara yang sama tetapi dengan variable yang berbeda 

sesuai dengan yang diinginankan. 

 

Gambar 57 Hasil Analisa 

 

 

 


